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Preface

This user guide:

Describes requirements on how to configure RAID mode on AMD platforms.
Provides information about arrays, disks, and RAID levels (RAID types).

Describes how to improve storage system performance or reliability by understanding
array and disk tasks and options.

Describes the procedures on how to acquire and load RAIDXpert2 drivers for supported
Microsoft® Windows® operating systems and Linux® operating systems.

Describes supported features and procedures for using RAIDXpert2, which is the
RAIDXpert2 GUI.

Intended Audience

This user guide is intended for use by system administrators and technicians who are experienced
with the following:

Direct Attached Storage (DAS), Storage Area Network (SAN), or Network Attached
Storage (NAS) operators

Network administration
Network installation
Storage system installation and configuration

Prerequisites

Prerequisites for installing and configuring this product include familiarity with:

Servers and computer networks
RAID and input/output signal technology (such as SCSI, SATA, or NVMe)
Fibre Channel and Ethernet protocols
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Document Conventions and Symbols

Table 1. Document Convention

Convention

Element

Navy blue, underlined text
(http.//www.example.com)

Web site addresses

Bold font Key names
Text typed into a GUI element, such as into a box
GUI elements that are clicked or selected, such as menu and
list items, buttons, and check boxes

Italics font Text emphasis

Monospace font

File and directory names
System output

Code

Text typed at the command line

Monospace, Italic font

Code variables
Command line variables

Monospace, bold font

Emphasis of file and directory names, system output, code,
and text typed at the command line

Customer Support

For customer support, contact your system supplier or motherboard vendor.

Glossary
Table 2. Glossary of Terms
Term Definition
rcadm A command line interface (CLI) tool for managing RAID controllers on
Linux®, on Windows®, and UEFI operating systems. It is used for
creating, transforming, and deleting arrays; and adding and removing
disks.
disk Legacy disks include new or unrecognized disks which may contain data
or even an operating system. Legacy disks appear in the RAIDXpert2
Configuration Utility (HII) as legacy arrays. When the legacy disk is
initialized, configuration data is written to the disk. The legacy array
then becomes an online disk usable in arrays.
CAUTION: A legacy disk can contain valid data. When a legacy disk is
initialized, all data on the disk is lost.
Linux® Free, open-source UNIX-based operating system.
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Chapter 1 Getting Started

1.1 AMD RAIDXpert2 Technology

AMD RAIDXpert2 consists of the following:
e Storage management application

e RAID controller and port virtualization

AMD RAIDXpert2 runs on existing systems by using a motherboard’s built-in SATA ports, PCle
M.2 slots, and PCle NVMe add-in cards.

e AMD-RAID Bottom Device (rcbottom) — WDF-based bus driver
e AMD-RAID Controller (rcraid) [storport] — Virtual Storport miniport driver
e AMD-RAID Config Device (rccfg) — WDM-based config device

1.2 Who Should Use This User Guide

Only trained, experienced, and authorized personnel should install RAIDXpert2 and use its
features and capabilities.

All unit operators must be familiar with system hardware, data storage, RAID technology,
input/output signal technology (such as NVMe, SCSI, SAS, or SATA), and Direct Attached
Storage (DAS), Network Attached Storage (NAS), and/or Storage Area Network (SAN) concepts
and technology.

The intended user audience of this user guide is system administrators and experienced users.

1.3 Supported Operating Systems
RAIDXpert2 supports the following 64-bit operating systems.

Mobile, desktop, and workstation:
e Microsoft® Windows® 10 and Windows 11°®

Workstation only:
e Red Hat® Enterprise Linux® (RHEL) 8., 9.x

e Ubuntu® Linux, 22.04.x, 24.04.x

For software installation steps, refer to the following documents:
e AMD RAID Quick Start Guide for Windows Operating Systems, order# 56268

e AMD RAID Quick Start Guide for Red Hat (RHEL) Operating System, order# 56963
e AMD RAID Quick Start Guide for Ubuntu Operating Systems, order# 56966
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e AMD RAID Quick Start Guide for Ubuntu Server, order# 58503

1.4 Controller Count and Configuration

Table 3 shows allowable controller and configuration maximums, based on the installed driver.

Table 3. Maximum Controller Count and Configuration

Component

For Systems with Driver 9.3.3

Max Controller Count

18 controllers: 16 NVMe + 2 AHCI (or 15 NVMe + 3 AHCI):
'Two controllers with device 1D 0x7917 or 0x43BD and NVVMe (one per NVMe)

Maximum Configuration

22 arrays for deletion

12 arrays for creation

22 devices (16 NVMe + 6 SATA)
8 devices per array

Note: Desktop/Mobile/x399/Workstation systems with driver 9.3.3 support S0i3, S3, and S4.

1.5 Features of RAIDXpert2

The features of RAIDXpert2 described in Table 4 apply to all supported operating systems.

Table 4. RAIDXpert2 Features

RAIDXpert2 Feature

Description

Arrays (general
information)

RAIDXpert2 allows:

o An array refers to data storage created by RAIDXpert2 from one or more
disks. An array can be created from several disks, but it is seen by the
operating system as a single disk.

o Creating arrays of different RAID levels using the same disks.

o Creating different RAID level arrays on the same disk to adapt each array
to the 1/O that it processes.

o Dissimilar Disk Support within the Same Array
e Online RAID Level Migration (ORLM)

Array Creation

Instant Create support and Create Array Functions without Rebooting:
¢ No initialization

¢ Foreground initialization

¢ Background initialization

Array Deletion

Delete Array Functions without Rebooting
e Single
o Multiple

Array Hiding

¢ An array can be hidden from the operating system so that neither the
software nor users can see or access it.

Chapter 1

Getting Started 19




[Public]

AMDZ1

AMD RAID® User Guide

53987 Rev. 3.31 April 2025

Table 4. RAIDXpert2 Features (Continued)

RAIDXpert2 Feature

Description

Array Recovery

If a redundant array is accidentally deleted, it might be recovered by
creating a new array with the same properties as the deleted array. (This
can occur only if disk Write Access operations are not in-progress.)

Array Transformation

Transform from one RAID level to almost any other RAID level.

Background Array
Initialization (BGI)

Background initialization allows a redundant array to be used immediately.
Data is not lost if a disk goes offline prior to completion of the BGI
process.

Cache Support for Arrays

Various array-caching options are supported:
e No Cache

e Read Ahead Cache

e Write Back Cache

¢ Read Ahead and Write Back Cache

Cache Support for Disks

Various disk-caching options are supported:
e No Cache

¢ Read Ahead Cache

e Write Back Cache

¢ Read Ahead and Write Back Cache

Note: By default, NVMe Physical disk Read Ahead and Write Back cache
are always disabled. User cannot enable the setting because it may
impact the operational performance of the NVMe disk.

Controller Spanning

RAIDXpert2 was architected to ensure spanning support and a common
interface API to the underlying hardware. This allows creating a RAID
Virtual Disk spanning across devices connected to the AMD chipset, AMD
processor, and/or NVMe controllers.

Consistency Check

A Consistency Check is a background operation that verifies and corrects
the mirror or parity data for fault-tolerant disks. It is recommended that a
Consistency Check be run periodically on an array.

Options:
¢ Background redundancy check
e Scheduled
Device Interfaces e SATAHDD o ATAPI
Supported e SATASSD e PCle NVMe SSD
e M.2SATASSD e U.2 device
e M.2 NVMe SSD e U.3 device

Dissimilar Disk Support
within the Same Array

Creating an array from a mix of different type disks is allowed but not
recommended because of the performance impacts.

For example, a RAID10 array can be created from a group of disks that
contain two SATA HDDs and two SATA SSDs, or only one NVMe or a
group of SATA and NVMe disks.

20
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Table 4. RAIDXpert2 Features (Continued)

RAIDXpert2 Feature

Description

Drive/Disk Roaming

With disk roaming, SATA cables can be disconnected from their disks and
shuffled without confusing RAIDXpert2.

Note: Disconnect SATA cables from disks only when system is shutdown.

Disk roaming allows:

e Same system: Devices can be moved to different locations; RAIDXpert2
detects which devices belong to which arrays, regardless of device
location.

e Between systems: Device(s) to be moved between systems.

Note: It might not be possible to move disks between systems if they
contain the AMD RAID boot array.

Fault Tolerance

The following fault tolerance features are available with RAIDXpert2 to
prevent data loss in case of a failed disk.

e Disk failure detection (automatic).

¢ Array rebuild using hot spares (automatic if the hot spare is configured
for this functionality).

¢ Hot swap — the manual replacement of a SATA device without
rebooting the system (only available in systems with backplanes that
support hot swap)
Note: Hot swapping is not recommend for disks that are part of the Boot
Virtual Disk or are connected to the AMD RAID supported chipsets.
This applies to all chipsets.

Hot-Swap Support

Hot-swapping is not recommended for disks that are part of AMD RAID
boot array.

Mirror Rebuilding

A broken mirrored array can be rebuilt after a new disk is inserted and the
disk is designated as a spare. The system does not require rebooting.

Native Command Queuing

(NCQ)

Native Command Queuing is a command protocol of SATA disks that are
supported by RAIDXpert2. NCQ enables individual disks to internally
optimize the order in which Read and Write commands are executed.
RAIDXpert2 permits a maximum queue depth of up to 32 read/write
commands per disk.

Online Capacity
Expansion (OCE)

OCE is a process that allows the user to add storage capacity to an existing
array without taking the system offline. It enables the user to increase total
storage capacity of an array by integrating unused storage into the array.
Data can be accessed while the disks are added and while data on the array
is being redistributed.

Chapter 1
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Table 4. RAIDXpert2 Features (Continued)

RAIDXpert2 Feature

Description

Online RAID Level
Migration (ORLM)

e Users can easily move an array from one RAID level to another. This
can be useful if the array type used is not the optimal type for the
application.

¢ This function depends on array capacity, redundancy level, and capacity
of the drive or free space available.

e While the migration is taking place, data is accessible and protected to
the lowest protection of either the source RAID level or the destination
RAID level.

RAID Level Support

RAIDXpert2 supports:
e RAID levels 0, 1, 5, 10, Volume, and RAIDABLE

o Multiple RAID Levels per Disk: Support for multiple array levels per
disk allows the administrator to create arrays of different RAID levels
using the same disks.

Restore (Rebuild) Priority

RAIDXpert2 has the ability to set the Priority of the restore task.

Secure Erase

All data on an array can be erased and ensured it is unrecoverable, even
with advanced data recovery techniques.

Self-Monitoring Analysis
and Reporting Technology
(SMART)

SMART is a hard-disk-drive (HDD) capability that allows reliability
information reporting. If a drive anticipates a high likelihood of future
failure, it triggers a SMART error condition. RAIDXpert2 presents this
error condition so the drive can be replaced before the predicted failure.

Sparing

Global — Spare disk that is shared by multiple arrays
Dedicated — Spare disk assigned to a specific redundant array

Trim Support

Allows the OS to inform the SSD about deleted data so it can optimize
performance. Simple and Advanced Trim types are supported.

Note: RAID5 does not support Trim.

UEFI Driver (BIOS)
Support

o Create array

Delete array

RAIDXpert2 Configuration Utility (HII)
EFI shell utility (rcadm)

22
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Chapter 2 Understanding Arrays, Disks, and
RAID Levels

2.1 Understanding Arrays

Arrays are several disks that are grouped together to improve either the performance or reliability
of a storage system. Because some RAID levels enhance performance while others improve
reliability, it is important to consider the user’s needs when planning an array configuration.

Note: It is highly recommended that this user manual be reviewed in its entirety before
configuring arrays. Some of the advanced features of RAIDXpert2 (such as sparing options)
must be understood by the user before creating arrays.

2.2 RAID Levels

RAIDXpert2 supports the RAID levels indicated in Table 5.

Table 5. RAID Levels — General Characteristics

RAID Level Main Characteristic Use/Usefulness

RAIDO (Striping) | e Provides the highest performance |e RAIDO arrays are useful for

but no data redundancy. Data in holding information, such as the
the array is striped (distributed) operating system paging file,
across several disks. where performance is extremely
e Supports 2-8 disks. important, but redundancy is not.
RAID1 e Mirrors data on a partition of one | e  Useful when there are only two
(Mirroring) disk to another. disks available and data integrity
e Supports 2 disks. is more important than storage
capacity.

RAID10 (Striped |e Combines mirrors and stripe sets. | e  Offers better performance than a

RAID1 Sets) RAID10 allows multiple disk simple mirror because of the extra
failures, up to 1 failure in each disks.
mirror that has been striped. e Requires twice the disk space of
e Supports 4, 6, or 8 disks. RAID1 to offer redundancy.
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Table 5. RAID Levels — General Characteristics (Continued)

RAID Level Main Characteristic Use/Usefulness
RAID5 e Stripes data as well as parity, o  Offers exceptional read
across all disks in the array. performance and redundancy.
e Inthe event of a failure, e Write performance is not an issue
RAIDXpert2 can restore the lost due to the tendency of the
data of the_ ff;uled .dISk from the operating system to perform many
other surviving disks. more reads than writes.

*  Supports 3-8 disks. e Requires only one extra disk to

offer redundancy.

e For most systems with three or
more disks this is the correct
choice for a RAID level.

Volume (JBOD) |e RAIDXpert2 treats one or more Provides the ability to link-together

disks or the unused space on a storage from one or several disks,
disk as a single array. regardless of the size of the space on
e Supports 1 to 8 disks those disks.

Useful in scavenging space on disks
unused by other disks in the array.
Does not provide performance benefits
or data redundancy. Disk failure will
result in data loss.

RAIDABLE (also | e Allows a RAIDABLE disk to be | See RAIDO (Striping), on page 23 or
known as RAID transformed later to RAIDO or RAID1 (Mirroring) on page 23 for
Ready) RAIDL. post-transformation usefulness.

e Supports one disk.

2.3 Array States

Within the management applications, an array is a logical device that can exist in one of four
states: Normal, Ready, Critical, or Offline.

e In RAIDXpert2, these states display in the Array List section in a column named State.

e Within the rcadm Command Line interface, these states also display in a column named
State.

The array states are defined in Table 6, on page 25.
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Table 6. Array States

AMD RAID® User Guide

State Description

Normal The Normal state is displayed when everything is functioning correctly.

Ready The Ready state is displayed while an array is being created.

Critical The Critical state is displayed when the array is no longer redundant (fault
tolerant) because of one or more disk failures. Arrays can still be read and written
to, but the data is no longer protected should another disk fail.

Offline The Offline state is displayed when arrays cannot be read or written to because of
one or more disk failures.

Whether an array is marked as Critical or Offline depends upon what RAID level it is and how

many disks within the array have failed. Note the changes in state in Table 7.

Table 7. Device Failure by RAID Level

RAID Level Failure State Is Displayed Whenever
RAID1 Critical A single disk fails.
(Redundant Arrays)
Offline Two disks fail.
RAID10 Critical A single disk fails in any one of the sets.
(RAID Levels with Multiple
Redundancies)
Offline All the disks in a set fail.
Volume, RAIDABLE and RAIDO Offline A single disk fails.
RAID5 Critical A single disk fails.
(Redundant Array)
Offline Two disks fail.

More than one array can be created using the same set of disks. If a disk is disconnected that

belongs to more than one array, only the arrays that try to access the disk and receive 1/O errors

report the failure. For example: there are two arrays, both of which are RAID1 sets and both use

Chapter 2 Understanding Arrays, Disks, and RAID Levels
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disk 4. If a system that is being used by array 1 receives an 1/O error when trying to communicate
with disk 4, the state of array 1 changes to Critical. However, the state of array 2 using disk 4 does
not change to Critical until an 1/0 error is reported. If systems using array 1 are not
communicating with failed disk 4, the state of array 1 still displays as Normal.

If a rescan of all channels is performed after disconnecting a disk, the state of every array using
the missing disk changes from Normal to either Critical or Offline, depending on the RAID level.

See Section 2.9, Rescanning Disks for Changes in State, on page 30 for a discussion of when to
rescan disks and the outcomes when doing so.

2.4 Creating Arrays: Future Expansion

When creating arrays, consider whether disk capacity needs to expand in the future. If the file
system must be expanded, perform the tasks indicated in Table 6

Table 8. Array Expansion Considerations

ey Do This... And Consider This...
System
Microsoft® | Format the arrays with NTFS. 1. The Diskpart.exe utility version depends on
Windows® Microsoft Corporation provides a which version of the Windows operating
utility (Diskpart.exe) that can system is running.
dynamically extend an NTFS file 2. The Diskpart.exe utility can be found on the
system onto any unused adjacent space. | CD for some versions of Windows operating
Note also that using a single partition systems, or on the Microsoft Corporation
per array makes expansion much easier. | website (http://www.microsoft.com) for
other versions. Use the correct version for the
operating system.

Linux® Use an expandable file system. Because RAIDXpert2 software is limited to
twelve arrays, if a large number of logical
volumes are needed, use a logical volume
manager (LVM).

2.5 Expanding Array Capacity Online: Using OCE

Online Capacity Expansion (OCE) allows:
e Adding disks to an array at any time to increase an array’s capacity.

e Accessing the array data while it is being redistributed.

To increase the size and organization of an array, transform the array. For more information about
transforming arrays, see Section 4.4.3, Transform Arrays on page 57.
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2.6 Migrating RAID Levels Online: Using ORLM

Online RAID Level Migration (ORLM) allows an array to move from one RAID level to almost
any other RAID level. This task includes migrating the array from a non-redundant RAID level to
a redundant RAID level.

Prior to starting a RAID level migration/transformation, make sure that the disks selected for the
destination array have sufficient capacity. RAID level migration/transformation can occur only
when the destination array has the same or larger capacity as the source array.

While the migration/transformation is taking place, data is accessible and protected to the lowest
protection of either the source RAID level or the destination RAID level.

The Transform task can also be used to expand the capacity of an array, by using OCE. It can also
be used as part of the system backup and recovery strategy using the RAID1 and RAID10 levels.

To perform this process, see Section 4.4.3, Transform Arrays on page 57.

2.7 Array Tasks: Starting and Stopping Tasks

Tasks are started when one of the following actions are performed:
e Create a redundant array.

e Transform an array.

e Restore an array.

e Securely erase an array.

e Check for consistency on redundant arrays.

e Verify that data was not corrupted after a system crash (Check Bitmap performed
automatically).

Full task control can be used on Create, Consistency Check, and Bitmap Check tasks. On a
Transform or Restore task for dedicated and global spares, task control can only pause/resume, but
it cannot remove the task. To remove these types of tasks, pause and then remove them.

The tasks indicated in Table 9 on page 28, can be displayed for each array.
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Task When Displayed
Transform While an array is being transformed.
Create While an array is being created.

Consistency
Check

While verifying the mirror disk (RAID1 or RAID10) consistency is correct.

(For redundant type arrays only.)

Restore

While an array is being restored.

Secure Erase

While an array secure erase is being performed.

Check_Bitmap

While verifying that the mirror halves on a RAID1 or RAID10 set, are
consistent. This action is performed automatically to ensure that data is not

corrupted whenever a system crashes.

Not_Active

When no other tasks are being performed.

2.8 Understanding Disks

2.8.1 Disks St

ates

Within the management applications, a disk can be part of one or more arrays and can exist in one
of five states: Online, Offline, New, Legacy, or SMART Error.

e In RAIDXpert2, these states are displayed in the Disk List section in a column named
State. See Table 16, on page 48, for additional information.

e Within the rcadm command line interface, these states are also displayed in a column
named State. See Table 28, on page 72, and Table 29, on page 74, for additional

information.

The disk states are def
Table 10. Disk States

ined in Table 10.

Disk State

When Displayed

Online

communicate with it.

Whenever the disk is connected, functioning correctly, and RAIDXpert2 can

28
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Table 10. Disk States (Continued)

Disk State When Displayed

New Whenever an uninitialized, new disk is connected.

Legacy Whenever a disk containing non-RAIDXpert2 configuration data is connected.

Offline Whenever the disk fails and RAIDXpert2 detects an error condition on the disk.

SMART Error Whenever the disk reports a SMART error(s) to RAIDXpert2.

A disk can be a member of multiple arrays. A disk failure in one array doesn't necessarily mean it
has failed in other arrays.

After a rescan is performed the following can occur:

e A disconnected disk no longer appears in the Disk List (although the disk appears as
Missing in the Array View for the arrays to which it belonged).

e A disk that experiences a catastrophic failure appears in the Disk List as Offline and is
highlighted in red. The disk appears as Failed for the arrays to which it belonged.

e Adisk that has a SMART error appears in the Disk List as SMART Error. (A disk with a
SMART error cannot be used to create an array)

e A disk that experiences a software-related failure appears in the Disk List as Online and is
highlighted in red. New arrays can be created with the disk.

Arrays that exist on a failed or disconnected disk might not be designated as Failed or Missing
until the system attempts to communicate with the failed or disconnected disk.

2.8.2 Disks

A legacy disk is a disk that contains valid data from a Non-AMD RAID controller.

A legacy disk appears in RAIDXpert2 GUI and RAIDXpert2 Configuration Utility (HII) with a
corresponding legacy array. When the legacy disk is initialized in RAIDXpert2 GUI and
RAIDXpert2 Configuration Utility (HII) the legacy array disappears.

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted the data is lost.
2.8.2.1 Legacy Disk and New Disk

Table 11 provides information on how disks appear in RAIDXpert2 GUI and RAIDXpert2
Configuration Utility (HII).
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Table 11. New and Legacy Disks, as They Appear in the RAIDXpert2 Configuration Utility
(HII) and RAIDXpert2

Status of the Disk RAIDXpert2 Utility In the BIOS Configuration
Utility/RAIDXpert2
Configuration Utility (HII)

New, un-initialized disk. The disk appears as a new disk | The disk appears as a new disk
with a legacy array. (the disk can appear with a
When the new disk is legacy array).
initialized, its state changes to | When the new disk is
Online (or similar). initialized, RAIDXpert2

configuration data is written to
the disk. The disk state changes

to Online.
A disk containing non- The disk appears as a legacy The disk appears as a legacy
RAIDXpert2 configuration disk with a legacy array. disk with a legacy array.
data. When the legacy array is When the legacy array is
CAUTION: A legacy disk can | deleted, the legacy array deleted the state of the legacy
contain valid data. When a disappears and the legacy disk | disk changes to Empty. The
legacy array is deleted, or type changes to Disk. The disk | disk can now be used in
when its corresponding legacy | can now be used in RAIDXpert2 arrays.
disk is initialized, the data is RAIDXpert2 arrays.
lost.

Note: A Native AHCI installation will not boot into the OS, after changing the BIOS settings to
RAID mode.

See Chapter 4, AMD RAIDXpert2 Graphical User Interface (GUI), on page 46, for the disk
initialization procedure and the appearance of legacy disks in the BIOS Configuration Utility.

2.9 Rescanning Disks for Changes in State

The information displayed in the Disk List section is the state of the disks when they were last
scanned. If a rescan has not been performed, the information displayed is the state of the disks at
boot time.

Every time a disk is connected or disconnected while online, a message asks if the user wants to
perform a rescan (of all devices/controllers). If Rescan is selected, the information in both the
Array List and the Disk List is updated. This view might show arrays as being in a Critical or
Offline state if all disks have not been installed or removed.

Although it is highly recommended that the system be shut down before adding or removing disks,
disks can be added or removed while the system is online (“hot-swapping”), if the system supports
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the hot-swapping function. This is not recommended for disks that are part of the Boot Virtual
Array or those that are connected to the AMD RAID supported chipsets.

Because of this function, RAIDXpert2 does not automatically perform a rescan when it detects
that a disk has been added or removed. For example, to hot-swap a RAID1 set with two disks into
a new system, do not perform a rescan until both disks have been connected.

Arrays associated with the disks that are not yet connected change state to either Critical or
Offline. In the example above, if the state of the RAID1 set changes to Offline, data is unavailable.

Rescanning can also result in the state of a disk being reported differently in the Array View and
the Disk List. A disk within an array can have a state of Failed in the Array View field, while at
the same time it can show a state of Online in the Disk List.

2.10  Sparing Options: Disks and Arrays

RAIDXpert2 supports multiple sparing options. Spares are restored in the order indicated in
Table 12.

Table 12. Sparing Options

Option Description
Dedicated A spare disk assigned to a specific redundant array.
Global A spare disk that is shared by multiple arrays.

Note: An array is marked Critical or Offline if a disk reports a Failed state to an 1/O, or if the
Disk, SATA cable, or power cable is disconnected.

Note: One or more spares can be assigned to a redundant RAID level.

Note: Spare assignments do not apply to non-redundant RAID levels. To protect data, transform
the array to a redundant RAID level. Spares can then be assigned.

2.10.1  Dedicated Sparing

A dedicated spare is a disk that is assigned as an alternate disk for a specific array. Should a disk
fail in that array, the alternate disk is used to replace the failed disk and the array is rebuilt.

A dedicated spare can be assigned to any redundant array type, and up to four spares can be
assigned to an array.

Note: Disk capacity of the Dedicated Spare must be greater or equal to the capacity of the
smallest disk in the array.
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CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an
automatic restore is not guaranteed if a disk fails. If a disk fails, make space on the
disk for the fail-over to complete, or assign a different disk with enough space. If a
dedicated spare is assigned and a disk fails, the restore process starts automatically,
if there is enough space available on the dedicated spare.

For additional information, see Section 4.4.12, Add or Remove Dedicated Spares, on page 65.
2.10.2  Global Sparing

A global spare is a disk that is assigned as an alternate disk for multiple arrays, instead of
associating it with only one array.

Many arrays can be restored using the global spare disk, if it is not already part of the array and it
has enough space available. Unlike a dedicated spare, this type of spare can be assigned at any
time, even while tasks are running on arrays.

Assigning a disk for use as a global spare does not reserve space on that disk. An automatic restore
is not guaranteed if a disk fails.

If there is not enough disk space on the global spare, make room for the fail-over to complete, or
assign a different disk with enough capacity as the spare. If there is enough space available on the
global spare and a disk failure occurs, the restore process starts automatically.

For additional information, see Section 4.4.13, Add or Remove Global Spares, on page 65.

2.11 RAID Performance Considerations
With RAID technology, performance is based on the following considerations:

e The number and organization of disks in an array.

e Caching attributes used for the array.

e Application workload.

e Array level verifies that the array creation completes before running performance testing.

Note: AMD recommends not using SMR hard drives with AMD RAID systems because it can
cause poor performance or failures. SMR drives are not suitable for workloads that require
many random writes (such as boot drive). If used with RAID, the multiple SMR drives and
background RAID tasks (such as creates and rebuilds) compound any issues or problems.

Note: — In certain situations, RAID scaling may not meet expectations. A future release is
planned to address this issue.
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2.11.1  Number and Organization of Disks

RAID functions increase performance by putting more disks to work and by buffering data for the
host.

Many disks can transfer data at greater than 100 MB per second. RAIDXpert2 can aggregate this
bandwidth in an almost linear fashion, as more of the same disks are included in an array.

2.11.2  Caching Attributes

Arrays can also be configured to provide Read and Write Back cache, Write Back, Read Ahead
cache, and No cache option with RAIDXpert2 configuration utility and GUI utility, if desired.
Write Back caching has a large effect on most workloads but should be used with caution.

2.11.3  Application Workload

When configuring an array, workload is probably the most important performance variable. Most
applications do many more reads than writes. The best performance is obtained with array types
like RAIDO or RAID10.

2.12 RAID Reliability Considerations

RAID reliability is enhanced through data redundancy and backup.

2.12.1  Data Redundancy

RAID1, RAID5, or RAID10 are necessary for redundancy. With redundancy, both capacity and
performance are sacrificed for reliability. With RAIDXpert2, extremely high performance is
obtained even with redundant-type arrays.

2.12.2  Backup

It is good practice to back up your data periodically in case of a catastrophic failure. Tape backup
or other media can be used to secure your data.

2.13  Multiple RAID Levels

With RAIDXpert2, different RAID levels can be created on the same disk, to adapt each array to
the 1/0 that it processes. Also, more than one array can be created per disk.

Depending on the array capacity and redundancy level, an existing array can be transformed to
another RAID level, if the level of the array being used is not the optimal RAID level for the
application. Also, different arrays with different characteristics can be built for different
applications.
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Chapter 3 AMD RAIDXpert2 Configuration
Utility (HII)

The RAIDXpert2 Configuration Utility is also known as the HII. Use the utility to accomplish the
procedures indicated in Table 13.

Table 13. When to use the AMD RAID RAIDXpert2 Configuration Utility (HII)

Procedure Description Find Information At
Initialize a new To initialize a new disk drive for data | Section 3.2, Initialize Disks, on page 35
disk storage.
Create Arrays Create arrays at different RAID levels | Section 3.3, Create Arrays, on page 36
Delete Arrays Delete an array Section 3.4, Delete Arrays, on page 41
Manage hot Allows selection of global and Section 3.5, Manage Spares, on page 41
spares dedicated hot spares.
View Controller | View information about each Section 3.6, View Controller Details, on page 43
details controller. Section 3.7, View Disk Details, on page 44
View Disk details | View information about each disk. Section 3.6, View Controller Details, on page 43
View Array View information about each array. Section 3.7, View Disk Details, on page 44
details
Rescan all Rescan all channels to detect new or | Section 3.9, Rescan All Channels, on page 45
channels removed disks and arrays.
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3.1.1 Access the AMD RAIDXpert2 Configuration Utility (HI1) AMI BIOS

To enter the RAIDXpert2 Configuration Utility (HII) based on AMI BIOS, complete the
following:

1. Power ON the system.

2. Press DEL.

3. Inthe Menu Bar, select Advanced.

4. Select RAIDXpert2 Configuration Utility, then press Enter.

3.1.2 Access the AMD RAIDXpert2 Configuration Utility (HII) Insyde
BIOS

To enter the RAIDXpert2 Configuration Utility (HII) for Insyde BIOS, complete the following:

1. Power ON the system.

2. Press ESC.

3. Select Device Management, then press Enter.

4. Select RAIDXpert2 Configuration Utility, then press Enter.

Note: If the BIOS Configuration Utility does not display, contact your system or motherboard
supplier.

3.1.3 Access the AMD RAIDXpert2 Configuration Utility (HI1) AMD NDA
BIOS

To enter the RAIDXpert2 Configuration Utility (HII) based on AMD NDA BIOS, complete the
following:

1. Press DEL.
2. Inthe BIOS home page, select Device Manage.
3. Select RAIDXpert2 Configuration Utility, then press Enter.

3.2 Initialize Disks

New disks and legacy disks must be initialized before they can be used to create an AMD RAID
array.

Initialization writes AMD RAID configuration information (metadata) to a disk.

CAUTION: If a disk is part of an AMD RAID array, the disk cannot be selected for initialization.
To initialize the disk anyway, delete the AMD RAID array. Data on the disk is deleted
during initialization so ensure the correct disks are chosen to initialize.

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, all data on the
disk is lost.

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Physical Disk Management, then press Enter.
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2. Select Select Physical Disk Operations using the arrow keys, then press Enter.
3. Highlight Initialize Disk using the arrow keys, then press Enter
4. Select the disk(s) to initialize:
a. To select individual disks, highlight a disk with the arrow keys and press the space bar or
Enter. Multiple disks may be selected using this method.
b. When the desired number are selected, use arrow keys to select OK, then press Enter.

Review the warning message, if you want to proceed, use the arrow keys to select YES,
then press the Enter key, or press ESC to cancel the initialization.

Initialization takes 10 to 15 seconds per disk. During initialization, a complete rescan of all
channels is done automatically.

3.3 Create Arrays

Arrays can be created after the disks are initialized. See Section 2.2, RAID Levels, on page 23, for
deciding what type of RAID levels to use for the array.

TIP: See also Section 4.4.1, Create and Format Arrays on page 54, and Section 5.4, Create New
Arrays: rcadm --create, on page 76.

3.3.1 Before You Begin

e For redundant arrays the Create process starts after the operating system and AMD RAID
OS drivers are installed and the system is booted to the operating system. However, the
arrays are immediately available to use for either a bootable array or a data array.

e Array numbers are valid only for a given boot and might be different in the RAIDXpert2
Configuration Utility (HII) and RAIDXpert2 GUI. If a permanent label is required, use the
RAIDXpert2 GUI Array Naming feature.

e Atany point in the procedure return to a prior window by pressing ESC.

e |f the system is booted from an AMD RAID bootable array the first array in the Arrays
section must be the bootable array. The system boots only from the first array in the
Arrays section.

e AMD recommends not using SMR hard drives with AMD RAID systems because it can
cause poor performance or failures. SMR drives are not suitable for workloads that require

many random writes (such as boot drive). If used with RAID, multiple SMR drives and
background RAID tasks (such as creates and rebuilds) compound any issues or problems.

3.3.2 Create an Array

Before proceeding with array create and manage, System BIOS configuration should be setup as
mentioned in the Quick Start Guide section “Platform BIOS RAID Configuration Prerequisites”
for system RAID mode to be enabled.
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The RAIDXpert2 Configuration Utility can be used to create a bootable array with levels
Volume, Raidable, RAIDO, RAID1, RAID5 and RAID10. Configure array cache and Cache
tag size settings by following the steps mentioned in the following sections.

Table 14. Default Cache Tag Size

Array Type Default CTS
HDD Array 64 K
SSD Array
Mix of HDD/SSD Array
All NVMe Array 256 K
Mix of NVMe with HDD/SSD Array 256 K

Caution: Cache Tag Size for an array cannot be changed after creation.

To install the operating system and RAIDXpert2 files see instructions for software installation in
the Quick Start Guide.

3321 Create an AMD RAID Bootable Array

To install the operating system, AMD RAID Device driver and RAIDXpert2 GUI utility see
instructions for software installation in the Quick Start Guide.

CAUTION: Do not use eSATA devices or Devices located in Hot Swap bays, for your boot array,
as they can be removed.

CAUTION: It is recommended to create only one array for the OS installation. If more arrays are
needed, they can be created in the OS GUI/cli or HII, after the OS installation
completes.

3.3.2.2 Create a RAIDABLE Array
Note: Refer to Table 5 for RAIDABLE array characteristics.

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

4. From the Select RAID Level Drop down menu, use the arrow keys to select RAIDABLE,
then press Enter.

5. Select the disk with which to create the array:
6. Select Physical Disks using the arrow keys, then press Enter.

7. Select an individual disk, highlight a disk using the arrow keys and press the space bar or
Enter.

e Select Apply Changes using the arrow keys, then press Enter.
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Note: Refer to Table 14 on page 37 for Default Cache Tag Size.

8. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

9. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

10. Select Create Array using the arrow keys, then press Enter.

3.3.2.3 Create a VOLUME Array
Note: Refer to Table 5 for VOLUME array characteristics

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
VOLUME, then press Enter.

4. Select the disks with which to create the array:
a. Select Physical Disks using the arrow keys, then press Enter.
b. Select desired disks, highlight a disk (arrow keys), and press the space bar or Enter.
c. Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 14 on page 37 for Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.

3.3.24 Create a RAIDO Array
Note: Refer to Table 5 for RAIDO array characteristics

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
RAIDO, then press Enter.

4. Select the disks to create the array:
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a. Select Physical Disks using the arrow keys, then press Enter.

b. Select desired disks, highlight a disk with the arrow keys and press the space bar or
Enter.

c. Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 14 on page 37 for Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.

3.3.2.5 Create a RAID1 Array
Note: Refer to Table 5 for RAID1 array characteristics

1. From the RAIDXpert2 Configuration Utility’s Main Menu, select Array Management
using the arrow keys, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
RAID1, then press Enter.

4. Select the disks to create the array:
a. Select Physical Disks using the arrow keys, then press Enter.

b. Select desired disks, highlight a disk with the arrow keys and press the space bar or
Enter.

c. Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 14 on page 37 for Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.

3.3.2.6 Create a RAID10 Array
Note: Refer to Table 5 for RAID10 array characteristics

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.
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2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
RAID10, then press Enter.

4. Select the disks with which to create the array:
a. Select Physical Disks using the arrow keys, then press Enter.

b. Select desired disks, highlight a disk with the arrow keys and press the space bar or
Enter.

c. Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 14 on page 37 for Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.

3.3.2.7 Create a RAIDS Array
Note: Refer to Table 5 for RAIDS5 array characteristics.

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Create Array using the arrow keys, then press Enter.
3. Select Select RAID Level using the arrow keys, then press Enter.

e From the Select RAID Level drop-down menu, use the arrow keys to select
RAIDS, then press Enter.

4. Select the disks to create the array:
a. Select Physical Disks using the arrow keys, then press Enter.

b. Select desired disks, highlight a disk with the arrow keys and press the space bar or
Enter. Select a minimum of three (3) devices for RAIDS.

c. Select Apply Changes using the arrow keys, then press Enter.
Note: Refer to Table 14 on page 37 for the Default Cache Tag Size.

5. Select Read Cache Policy using the arrow keys, then press Enter.
e Select the desired Read Cache Policy, then press Enter.

6. Select Write Cache Policy using the arrow keys, then press Enter.
e Select the desired Write Cache Policy, then press Enter.

7. Select Create Array using the arrow keys, then press Enter.
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3.4 Delete Arrays
CAUTION: Deleting an array permanently destroys all the data on the array. This action cannot
be undone, and it is very unlikely the data can be recovered.
CAUTION: Do not delete the first array listed in the Arrays section if it is the AMD RAID
bootable array. Doing this deletes the operating system and AMD RAID files.
CAUTION: Deleting secondary arrays in the RAIDXpert2 Configuration Utility (HII) after the
system resumes from a hibernation results in the arrays not being deleted. The system
boots from the previous hibernation configuration. If you want to delete secondary
arrays in RAIDXpert2 Configuration Utility (HII), reset the system, then enter
RAIDXpert2 Configuration Utility (HII) and perform the delete.
34.1 Delete an Array

1. From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

2. Select Delete Arrays using the arrow keys, then press Enter.
3. Select the array(s) to delete:

a.

3.5

Select the desired array or multiple arrays using the arrow keys, then press the space
bar or Enter to change option to Enabled for deletion.

If you want to select all the arrays, use the arrow keys to select Check all, then press
Enter.

Select Delete Array using the arrow keys, then press the space bar or Enter.

To select all the arrays for deletion: use the arrow keys to select Check all, then press
the space bar or Enter.

Review the warning message, if you want to proceed, press the space bar or Enter.
Select Yes using the arrow keys to delete arrays or press the ESC key to exit.

Manage Spares

This option allows the user to assign or unassign global or dedicated spares.
Note: To assign a physical disk as a Global Spare, it must not be part of any Array.

3.5.1

Assign Global Spares

1. From the RaidXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Physical Disk Management, then press Enter.

2. Select Physical Disk Operations using the arrow keys, then press Enter.
3. Select Select Physical Disk using the arrow keys, then press Enter.
4. Select Assign Global Hot Spare using the arrow keys, then press Enter.
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5. Review the warning message, if you want to proceed, use the arrow keys to select Yes, or

3.5.2

press ESC or No, to exit.

Assign Dedicated Spares

Note: Dedicated spares can only be assigned to redundant arrays and must the same size or
larger than the other members of the redundant array.

3.53

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

Select Manage Array Properties using the arrow keys, then press Enter.
Select Select Array using the arrow keys.

e Select the desired array (must be a redundant array) from the drop-down menu,
then press Enter.

Select Manage Dedicated Hot Spares using the arrow keys, then press Enter.
Select the disks to assign as dedicated spares.

a. Select the disk using the arrow keys to highlight the disk and press the space bar or
Enter to select it.

b. Select Add Hot Spare Physical Disk using the arrow keys, then press Enter.
At the warning message, press the space bar or Enter to Confirm.

d. Select Yes using the arrow keys, then press Enter or press the ESC key to exit adding
the Dedicated Spare.

Unassign Spares

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Physical Disk Management, then press Enter.

Select Select Physical Disk Operations using the arrow keys, then press Enter.
Select Select Physical Disk using the arrow keys, then press Enter.

From the drop-down menu, use the arrow keys to select the Global / Dedicated Spare,
then press Enter.

Select Unassign Hot Spare using the arrow keys, then press Enter.

Review the warning message, if you want to proceed select Yes, then press Enter or press
the ESC key to exit.
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3.6

View Controller Details

This option will display the details about of the controllers. Nothing can be changed using this
menu option; it is for informational purposes only.

1.

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Controller Management, then press Enter.

Select Select View Controller Information using the arrow keys, then press Enter.
Select Select Controller using the arrow keys, then press Enter.

From the drop-down menu, select the desired controller, then press Enter. Information
about the controller is displayed below the Select Controller header:

PCI ID

Controller Physical Disk Count

Total Physical Disk Count

Total Array Count

UEFI Driver Version

Firmware Properties/Firmware Build Time

To view another controller, press Enter and from the drop-down menu, select a different
controller, then press Enter.

Press ESC to exit to the Main Menu.
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3.7

View Disk Details

This option allows the user to view details about the physical disk(s). Nothing can be changed
using this menu option; it is for informational purposes only.

1.

w

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to highlight
Physical Disk Management, then press Enter.

Select View Physical Disk Properties using the arrow keys, then press Enter.
Select Select Physical Disk using the arrow keys, then press Enter.

From the drop-down menu, select the physical disk you want more information about, then
press Enter.

Information about the physical disk is displayed below the Select Physical Disk header:
e Unique Disk ID

e State

e Size

e Smart Status

e Revision

e Drive Type

e Maximum Free Space

e Used Space

e Disk Protocol

e Disk Speed

e Associated Array, if part of one
e Serial Number

e Model Number

To view another physical disk, press Enter and from the drop-down menu, select a
different physical disk, then press Enter.

Press ESC to exit to the Main Menu.
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3.8

View Array Details

This option will display the details of an array. Nothing can be changed using this menu option; it
is for informational purposes only.

1.

© N RN

9.

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Array Management, then press Enter.

Select Select Manage Array Properties using the arrow keys, then press Enter.
Select Select Array using the arrow keys, then press Enter.

From the drop-down menu, select the desired array, then press Enter.

Select View Associated Physical Disks using the arrow keys, then press Enter
Press the space bar to select one of the members of the Array

Select View Physical Disk Properties using the arrow keys, then press Enter
Information about the array is displayed below the Select Array header:

e Array number

e RAID level

e State (see Table 6)

e Size

e Cache Tag Size

e Cache settings

e Associated physical disks

To view another array, press ESC twice and perform steps 2 through 8 again.

10. Press ESC to exit to the Main Menu.

3.9

Rescan All Channels

This option allows the user to rescan all channels to detect new or removed disks and arrays. It
rereads the configuration information from each disk.

Sometimes when a disk is offline, it can be brought online through a rescan.

1.

From the RAIDXpert2 Configuration Utility’s Main Menu, use the arrow keys to select
Controller Management, then press Enter.

Select Rescan Disks using the arrow keys, then press Enter.
e After a rescan completes, all of the physical disks are displayed.
Select OK using the arrow keys, then press Enter.
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Chapter 4 AMD RAIDXpert2 Graphical User
Interface (GUI)

4.1 Start RAIDXpert2

The RAIDXpert2 graphical user interface (GUI) is a Desktop Application tool designed and
packaged to be a UWP compliant package, available from the Microsoft Store. It reads and writes
to the internal RAID drivers, which communicate with the AMD RAID arrays and physical
devices. Also available, is a version that is based off the Desktop application but is not UWP
compliant.

Open the Windows menu and search for AMD RAIDXpert2 or the desktop shortcut.

4.1.1 Desktop Shortcut Access
41.1.1 Signing in Using the RAIDXpert2 Desktop Shortcut

Open the Windows menu and search for AMD RAIDXpert2, click to open or make a desktop
shortcut, or pin to the taskbar.

4112 Help and About Windows

To view the software version and build number for the GUI, select About at the Help menu. The
AMD RAIDXpert2 Driver Version and GUI Version are displayed.

For reference help, select Help > User Guide. A PDF version of this document is displayed. A
PDF reader program is needed to view it.

For further customer support, click Help > Support for the AMD Drivers and Support page, or
contact your system supplier or motherboard vendor.

4.2 Reviewing the RAIDXpert2 GUI

4.2.1 The Array View Section of the Array Status Window
4211 Elements of the Array View Section

The Array View section presents a graphical view of array properties. Table 15 provides
information about the elements of the Array View section (see Figure 1 on 47).
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Table 15. Elements of the Array View Section, Array Status Window

Element Description
Controller Name The RAIDXpert2 controller for the arrays displayed below it.
Array The number assigned to an array.
Array name The name assigned to an array.
RAID Level The RAID level of the array.
Disk Number The number assigned to disks in an array.
Disk Manufacturer The manufacturer of disks in an array.
Disk Model Number The model number of the disks in an array.

O RAIDXpert2 - o X

File Array Disk View Help
m

Array View

pane Disk List pane

on  ArayName  Type Total Capacity &
NONE RAIDO 2,078 NC

Array List pane

Event List pane

| pisk: 6 10/ Host: 30.31G8

Figure 1. Array Status Window

422 The Disk List Section of the Array Status Window

4221 Elements of the Disk List Section
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The Disk List section provides information about all disks assigned or available to arrays. Table
16 provides information about the elements of the Disk List section.

Table 16. Elements of the Disk List Pane, Array Status Window

Element Description
Disk Controller and disk number.
State State of the disk (Online, Offline, SMART Error).
Type Disk type (Disk, Legacy, New).
Port Type Negotiated Speed (not the speed of the port type and SATA NCQ or NVMe
Capacity Disk capacity:

1 MB = 1,000,000 bytes

1 GB =1,000,000,000 bytes

Note: Because the ATA storage industry has standardized the meanings of
MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units

Space Available Total amount of space unused on the disk.

Largest Available Largest contiguous unused space on the disk.

Global Spare (GS) Indicates if the disk is assigned as a global spare.

Informed Hot Swap | Indicates whether a disk is enabled for live disconnect and removal.

Users Number of arrays that this disk is a member of.
Model Disk manufacturer’s model number.

Serial No. Disk manufacturer’s serial number.

Firmware Disk manufacturer’s firmware version.

If a disk is missing from the Disk List, the most likely causes are:

e A loose cable. Make sure that all disk cables are connected, then perform a rescan.

e Adisk that is not fully seated in its bay or slot. Make sure that the disk is inserted
completely in its bay or slot, then perform a rescan.
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423 The Array List Section of the Array Status Window
4231 Elements of the Array List Section

The Array List section provides information about the arrays. Table 17 provides information about
the elements of the Array List section.

Table 17. Elements of the Array List Section, Array Status Window

Element Description
Device The array number.
OS Name Corresponds to the Disk number in Windows Disk Management.
System If yes, it is your boot array, otherwise it is not a boot critical array.

Drive letter that was assigned to this array during the partition process. (A
blank space appears if the array has not been partitioned.)

Partition . .
artitio Note: If a dynamic volume is created on an array, RAIDXpert2 cannot
retrieve the volume’s drive letter.
Array Name User-created name for the array.
Type The RAID level (RAID type) or LEGACY.

Total capacity:

1 MB = 1,000,000 bytes

Total Capacity 1 GB =1,000,000,000 bytes

Note: The ATA storage industry standardizes MB as 1,000,000 bytes and
GB as 1,000,000,000 bytes, so RAIDXpert2 reports the same units.

State State of the array (NORMAL, CRITICAL, OFFLINE).

Task type, if in progress (TRANSFORM, CHECK, CHECK_BITMAP,

Task CREATE, RESTORE, ZERO, SECURE_ERASE).
The state of the task (STARTED, PAUSED, COMPLETED); the progress
Task State Lo . -
of the task is given in the Array View section.
Progress Percent given of a given task.
Pri Task priority if a task is in progress.
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Table 17. Elements of the Array List Section, Array Status Window (continued)

Element Description
Scan Background Array Scan enabled? (Yes/No).
Cache Current cache setting (NC = No Cache, R = Read Ahead Cache, W = Write

Back Cache, RW = Read/Write Cache).

Cache Tag size

Any Array with only HDD/SSD will have default CTS of 64k
Any Array with NVMe/HDD/SSD will have default CTS of 256k

Trim

No: Array does not support Trim. Yes: Array supports Trim.

Dedicated Spare

If assigned, the number of dedicated spares assigned to array.

4.2.4 The Event View Section of the Array Status Window

4241 Elements of the Event View Section

The Event View section is an optional-view section. It can be displayed or hidden by selecting

View > Event View.

The information in the Event View is linked to the View Log. The View Log displays user-
initiated tasks or actions, and system-generated notifications and events. The View Log can be
accesses by selecting View > Log.

The Event View provides information about the events. Table 18, on page 50, provides
information about the elements of the Event View section.

Table 18. Elements of the Event View Section, Array Status Window

Element

Description

# The number of the event.

Date The date and time at which the event occurred.

Event The RAIDXpert2 Asynchronous Event Notification (AEN) number of the event.

Priority The notification priority of the event: Low, Informational, Warning, Critical, or Fatal.

Text A brief description of the event.
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4.2.5 Array and Disk Commands

The Array and Disk menus of the Array Status window contain lists of commands. The commands
allow the system user to initiate or modify array- and disk-related tasks.

Not all commands are available for an array or for the system. Availability depends on:

e The tasks that can be performed with the system’s license level.

e The RAID level of an array. For example, a Consistency Check can be performed only on
arrays at a redundant RAID level.

e The remaining capacity of the disk drives. For example, if a system has three disk drives
and large arrays have used all of the capacity on two of the disks, only non-redundant
Volume arrays can be created on the remaining disk. Certain commands are not available
with a non-redundant array.

Table 19 provides page numbers for each command.

Table 19. Disk Menu Commands

Disk Commands See Detailed Information on this Page
Rescan page 51
Initialize page 51
Clear Metadata Page 52
Properties page 53
Options page 53

4.3 Working with Disks

4.3.1 Rescan Disks

The Rescan Command Performs the Following Actions:
e Rescans the devices/controllers and searchs for new, legacy, or removed disks.

e Rereads the configuration information from each disk.

When a disk is offline, it might be brought online by using a rescan. A rescan also stops and then
automatically resumes all tasks.

To rescan disks, select Rescan at the Disk menu.

4.3.2 Initialize Disks

When a disk is initialized, RAIDXpert2 configuration information (metadata) is written to the
disks. If a disk is new and has not been used before, or if it is a legacy disk, it must be initialized
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before it can be used in a RAIDXpert2 array. After a disk is initialized, it appears as Disk in the
Disk List.

If all the disks contain metadata, the Initialized button is deactivated (greyed out).

Note: All new disks and legacy disks will have an associated array. You must delete the array in
order to initialize the disk.

43.2.1 To Initialize Disks

1. Atthe Disk menu, select Initialize. The Initialize Disk window displays.
2. Select the disk(s) to be initialized, by selecting the box next to the disk(s).
3. Click Initialize Selected.

433 Clear Metadata Description

When a device has Clear Metadata applied to it, the RAIDXpert2 metadata is removed and the
device becomes a New/Legacy device.

If the device is part of an Array or is a New/Legacy device, it will not be available to be selected.
Also, if there aren’t any devices that are empty, the Clear Metadata button is deactivated (greyed

433.1 To Clear Metadata Steps

1. At the Disk Menu, select Clear Metadata. The Clear Metadata window displays.
2. Select the device(s) to be initialized, by selecting the box next to the device(s).
3. Click Clear Metadata.

434 Change Cache Properties for Disks

The Read Ahead and Write Back Cache properties can be changed if the disks support this option.
The default settings are:

e Read Ahead: enabled.
e Write Back Cache: enabled.

CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being
corrupted if the system experiences a power interruption or unexpected shutdown.

Note: 4 disk’s cache setting cannot be changed if a task is active for the array. The cache settings
are enabled when the task is finished.

Note: As default setting NVMe Physical disk Read ahead and Write Back cache is always
disabled. User cannot enable the setting as it may impact the operational performance of the
NVMe disk.
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434.1 Change Disk Caching Properties

At the Disk menu, select Properties.

The Properties window opens.

Select the disks you want to change the properties of.
Click Enable or Disable for the desired settings.

Mo

4.3.5 Options

Disk options include the following:
e Assign as Dedicated Spare

e Assign as Global Spare
e |dentify Disk Using LEDs
e Prepare to Remove

State Port Type Capacity Free Space Largest Free Global Spare Informed Hot Swap 1
Online MNYMe Gend xd 1.0TE 999.7GE 999.7GB Mo Yes
Cnline g MVMe Gend x4 1.0TB 0.0MB 0.0MB Mo Mo
Cnline ) MVMe Gend x4 1.0TB 0 3 ) Mo Mo
Online : 6G SATA/MCO 1.0TB 494.7GE 899.7G8 Ma Mo

Opticns X

Disk

O Prepare to Remove

Device OS5 MName Systern  Partition Array Mame Type

Array 1 0 Yes G NONE RAIDO Lok =

Figure 2. Disk Options
435.1 Assign a Disk as a Dedicated or Global Spare

Spare disks allow an array to be rebuilt when a disk fails. Global spares can be assigned and if a
redundant arrays fails, they will be automatically assigned, while dedicated spares are assigned to
a specific array.
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1. Select adisk in the Disk List section.
2. Select Options on the Disk menu.
A pop-up dialog lists options for Disk Device options.
3. Select one of the following:
e Select Assign as Dedicated Spare to use the disk as a dedicated spare.

Note: The capacity of a dedicated spare must be equal to or larger than the capacity
of the smallest disk in the array.

e Select Assign as Global Spare to use the disk as a global spare.
4. Click OK.

4.35.2 Prepare to Remove — Using Informed Hot Swap

Note: Only use this feature if there are no arrays on the device. Otherwise, see Section 4.4.5,
“Prepare to Physically Remove an Array.”

For systems that support Informed Hot Swap, a drive can be disconnected in software to prepare
for safe removal. This can be used when replacing a drive with a new larger drive or replacing a
failed drive.

To remove a device, select Disk Options > Prepare to Remove.

4.4 Working with Arrays

4.4.1 Create and Format Arrays

RAIDXpert2 allows the partitioning and creation of as many as twelve arrays across the system’s
disks. Portions of disks can be used to create arrays, while other arrays use different portions of
the same disks.

Table 20. Array Menu Commands

Array Commands Details
Create page 56 Hide page 66
Transform page 57 Identify Array page 49
Check Consistency page 63 Prepare to Remove page 60
Background Array Scan page 64 Remove Spares page 65
Modify Cache Settings page 62 Delete page 61
Task page 63 Delete Multiple Arrays page 61
Name page 57 Secure Erase page 66
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Figure 3. Array Options

44.1.1 Before You Begin

Review the issues and recommendations indicated in Table 21.

Table 21. Creating Arrays: Issues and Recommendations

AMD RAID® User Guide

Issues

Recommendations

Access to arrays

Creation of arrays, even redundant arrays, allows users immediate access to
the arrays (unless the Zero Create option is used during the Create process).

Array numbers

Array numbers are valid only for a given boot and can be different in the BIOS
Configuration Utility and RAIDXpert2. If a permanent label is required, use
the Array Naming feature, Name Arrays (Section 4.4.2, page 57).

Array size

Refer to the operating system documentation for details on maximum array
sizes.

Number of arrays

In some circumstances, more than twelve arrays are possible. They might
appear to function properly but are not supported by AMD RAID.

System reboot

When the system reboots, the creation process continues where it left off.
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44172 Create an Array

4.4.1.2.1 Select an Array and Cache
1. Select Create at the Array menu.

2. Select the disk(s) to include in the array by checking the box next to the desired disk(s) in
the Select Active Disks: field.

Note: Click All to select all disks, or click Unused to select disks that are not currently used in an
array. Maximum of 8 NVMe/HDD/SSD disks can be part of array. if more than 8 disks, the
Create button will be grayed out or unselectable.

3. Enter a name for the array in the Array Name: field.
Note: The following characters are not allowed in an array name.

( ) N\ , | = [13 2 . [ ]

4. Select an array type at the Array Type: drop-down menu.
5. Select an option at the Organized As: drop-down menu.

Note: The Organized As: drop-down menu only displays options for advanced management of a
RAID10 configuration if you selected RAID10.

6. Enter the capacity in the Capacity: field. The maximum available capacity changes with:
e The disks that are selected.
e The RAID level of the array.

7. Select a cache option at the Cache Options: drop-down menu. (The default is Read and
Write Back Cache.)

8. Cache Tag Size will default to a setting based off of the disks that are selected. All
HDD/SSD, default will be 64k. All NVMe or a mix of NVMe/HDD/SSD will default to
256k. The user should not change from the default settings.

9. Check Background Array Scan to enable background array scanning. (A background
array scan checks sectors of the disks in an array for potential problems. A background
array scan runs continuously, until the user stops it by accessing Array > Background
Array Scan > Stop.)

Note: Refer to Table 14 on page 37 for Default Cache Tag Size.
Note: Refer to Section 4.4.11, Scan an Array in the Background, on page 64, for details.

10. Check Skip Initialize to skip initialization.

CAUTION: Creating a redundant array with Skip Initialization selected can result in data
corruption.

11. Check Leave Existing Data Intact if an array is lost or deleted, and the user immediately
creates a replacement array of the same characteristics. This leaves the data on the disks of
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the lost or deleted array untouched when the replacement array is created. See Table 38, on
page 92, for additional information.

12. Check Zero Create to write zeros on the created array. If Zero Create is used, the array is
not immediately available. (The array is hidden from the operating system during the
Create process.)

13. Click Create to create the array.

4413 Partition and Format an Array

Each operating system has different names and paths for partitioning and formatting arrays and are
outside the scope of this document. For information, see operating system’s user documentation.

442 Name Arrays
Naming an array can be useful when creating backups. It makes an array easy to identify in a list.

1. Inthe Array View section, select the array to name.
2. Atthe Array menu, select Name. The Array Name window displays.
3. Type the desired name in the blank field.

Note: The following characters are not allowed in an array name.

( ) N\ , | = (13 b . [ ]
4. Click OK. The array name appears in the Array List and in the BIOS Configuration Utility
(only 17 characters of the name are displayed in the BIOS Configuration Utility).
443 Transform Arrays

With the Transform task, an array can be:
e Transformed from one RAID level to almost any other RAID level. This function is also
referred to as Online RAID Level Migration (ORLM).

e Expanded dynamically, even under 1/O load, by adding disks to the array to increase array
capacity. This function is also referred to as Online Capacity Expansion (OCE).

Note: If you transform an array by adding or removing a device located in the front panel(s), a
reboot is required to notify the Windows configuration of the underlying array/device
change.

4431 Before You Begin

Review the issues and recommendations indicated in Table 22.
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Table 22. Transforming Arrays: Issues and Recommendations

Issues Recommendations

Array size An array cannot be transformed to a smaller-sized array. The transformed array
must be the same size as or larger than the original array.

Array size limits Refer to the operating system documentation for details on maximum array
sizes.

Disk failure during a | If a disk fails while the Transform task is in progress, no data is lost if the
Transform source and destination RAID levels are redundant. If a spare has been assigned
to the destination array, a fail-over task starts as soon as the Transform
completes (if the spare is available after the Transform).

Multiple arrays If there are multiple arrays, it might not be possible to transform some of the
arrays to a larger size. If, in the future, an array needs to be expanded in size, it
is best to configure the available space as a single array.

Task control When using task control commands, a Transform task can only be paused or
commands resumed but not removed. To end a Transform task, pause and delete it.

Note: If a task is paused, then deleted, the array is deleted. Deleting a task is
the same as deleting an array. Data loss occurs when a task is deleted. Back up
data before deleting a task involving Transform or Restore.

System reboot during | If the system reboots during a Transform, the Transform continues where it left
a Transform off.

4.4.3.2 Transform an Array

1. Inthe Array View section, select the array to transform.
2. Atthe Array menu, select Transform.
Note: If the system window is not wide enough, only the Destination View is displayed.

3. Select all the desired disks for the array (including disks that might be already in the array)
by selecting the box next to the drive in the Disk List section.

Note: Click Same to select all disks currently used in the array, All to select all disks, or
Unused to select disks that are not currently used in an array.

4. Select the RAID level to be transformed at the Array Type: drop-down menu.
5. Select an option at the Organized As: drop-down menu.

Note: The Organized As: drop-down menu only displays options for advanced management
of a RAID10 configuration if you selected RAID10.
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6. Expand the array by entering the size of the new array in the Capacity: field. The
maximum available capacity changes with:

e The disks that are selected.
e The RAID level of the array.

Note: If a Transform is not possible, the Commit option is not enabled. A typical reason
preventing a Transform is insufficient available space on the disks.

7. Click Commit.

Note: Unless the transformation is instantaneous, the Array Status window updates to show the
source and destination arrays, along with the progress of the transformation.

4433 Access Additional Space

After an array has been transformed to a larger size, use the operating system tools to access the
additional space.

There are several possible methods for expanding the existing file system on an array that has been
transformed to a larger size:

e Microsoft provides a command prompt utility called Diskpart.exe that can expand any
NTFS file system without requiring a reboot. The Diskpart.exe utility version to use
depends on the version of Windows being run. The Diskpart.exe utility can be found on
the CD that comes with some versions of Windows, or at the Microsoft website
(http://www.microsoft.com) for others. Use the correct version for the operating system.

e For arrays formatted with FAT32, use a third-party application, such as PartitionMagic
from PowerQuest Corporation.

4.4.4 Restore (Rebuild) Arrays

With the Restore task, a redundant-type array whose state has changed to Critical can be restored
(rebuilt) in one of two ways:

e By assigning a dedicated spare to the array.

e By creating a global spare or by using an existing global spare. (An existing global spare
automatically starts restoring a redundant-type array after the array’s state changes to
Critical.)

An array in an Offline state cannot be restored. This means that non-redundant arrays (Volume,
RAIDO) cannot be restored: when a single disk in a non-redundant array fails, the array state
changes to Offline.

Note: If a Critical redundant array that is being restored loses a second disk (RAID1), or loses a
second disk in the same mirror set (RAID10), the Restore task fails. The array must be re-
created from backup storage data.
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4441 Before You Begin

e Make sure that the disk chosen as the dedicated spare or global spare has sufficient
available capacity to restore the array. The capacity of the spare disk must be equal to or
larger than the capacity of the smallest disk in the critical array.

e Know how to create a global or dedicated spare. See Section 4.4.12, Add or Remove
Dedicated Spares, on page 65 or Section 4.4.13, Add or Remove Global Spares, on
page 65.

4.4.4.2 Restore a Critical Array

1. Inthe Array View section, select the critical array.
2. At the Disk List section, double click on a disk.

3. At the Disk menu, select Options. Options for Disk Device displays in the Disk List
panel.

4. Perform one of the following actions:
e To use the disk as a dedicated spare, select Assign as Dedicated Spare.
e To use the disk as a global spare, select Assign as Global Spare.

5. Click Confirm.

4.4.5 Prepare to Physically Remove an Array
445.1 Physically Remove an Array
Informed Host Swap is available on workstations and only for systems that have front panels.

1. Select the array to remove in the Array View section.
2. Select Prepare to Remove at the Array menu.
3. Click Yes at the Prepare to Remove confirmation window.
The array is hidden from the OS, and the drives are disconnected from the OS.

4. Physically remove the disks from the system.

5. When all disks in the array are removed from the system, select Rescan from the
Drive Removed pop-up.

The array and all associated disks are removed from the Array and Disk Status windows.

4452 Array Migration

The disks in an array, after being removed from one system with a RAIDXpert2 controller, can be
migrated to another system with a RAIDXpert2 controller. The disks and array(s) appear in the
second system, in Disk Management, the BIOS Configuration Utility, and RAIDXpert2, as normal
RAIDXpert2 disks and array(s).
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After all drives from the array are inserted, a rescan is required. The array will be hidden from the

OS.

To unhide the array:

1. Select the array, and then select Un-Hide from the array pull-down menu.
2. Select Array > Un-Hide to display it.

If the disks from a RAIDXpert2 system are migrated to a non-RAIDXpert2 Windows-based
system, the disks appear in Disk Management of the second system as healthy, unknown

partitions. To use the disks, use Disk Management to delete the RAIDXpert2-created partitions

and to create Windows partitions on the disks.

CAUTION: All data contained in a RAIDXpert2 array are lost if the RAIDXpert2 disks of the
array are migrated to a non-RAIDXpert2 system.

446 Delete Arrays

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone, and it is very unlikely the data can be recovered.

446.1 Before You Begin

Review the issues and recommendations indicated in Table 23.

Table 23. Deleting Arrays: Issues and Recommendations

Issue

Recommendation

Drive letters or
partitions

Remove drive letters or partitions from the array using procedures in your
operating system. Each operating system has different names and paths for
removing drive letters or partitions and as such are outside the scope of this
document. For more information, see your operating system’s user
documentation.

Operating system
impact on arrays

If the array is not being used by the operating system, the array can be
deleted at any time, even while tasks are running on the array.

If the array is being used by the operating system, the array cannot be
deleted. Therefore, a RAIDXpert2 bootable array cannot be deleted in
RAIDXpert2. A RAIDXpert2 bootable array can only be deleted in the
BIOS Configuration Utility.
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4.46.2 Delete an Array

1. Inthe Array Status window, select the array to delete.
2. Atthe Array menu, select Delete. A window opens, warning about deleting the array.
3. Click Yes. The array disappears from the Array View section.

Note: Also see Section 5.5, Delete Arrays: rcadm --delete, on page 76.

4.4.6.3 Delete Multiple Arrays

1. Select Delete Multiple Arrays at the Array menu.

2. Select (check mark) the arrays you want to delete. The Select All button can also be used.
3. Click the Delete Button. A window opens, warning about deleting the array(s).

4. Click Yes. The array(s) will disappear from the Array View Section.

6.

4.4.6.4 Recreate a Deleted Array

If an array is deleted, it might be possible to recreate the array. See Table 38. Recreate a Deleted
Array, on page 92.

447 Cache Settings for Arrays
Table 24 provides information about the four array-caching options available.

Table 24. Cache Array Options

Option Description

No Cache I/0 requests are translated and passed to the disks without keeping a
cached copy of the data available for future requests

Read Cache Data reads are cached, if appropriate. This option performs sequential
Read Ahead, when necessary

Write Back Cache Data writes are cached. This setting is intended for advanced users who
understand the implications of Write Back caching

Read + Write Back Both Read and Write Back Cache options can be selected
Cache (default setting)

Note: Cache options cannot be changed while a task is active on the array. They can be changed
at any other time, including while 1/O is running.

4.4.7.1 Change Cache Settings

1. Select the array on which to change caching options in the Array View section.
2. Select Modify Cache Settings at the Array menu.
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3. Choose No Cache, Read Cache, Write Back Cache, or Read + Write Back Cache. The
new cache setting displays in the Array List Cache information.

4. Select Rescan at the Disk Menu.
448 Change the Priority Level of a Task
The task priority command allows the user to speed up or slow down tasks performed on arrays.
To decrease the amount of time for a task to complete, set the task priority higher (10 is highest).
Note: A task priority can only be changed after a task is running on the array.
448.1 Change a Task Priority

Select the array on which tasks are being performed in the Array View section.
Select Task and select Priority at the Array menu.

At the Task Priority window, change the task priority by moving the slide.
Click OK.

M owbdhe

449 Interrupt, Cancel, or Resume a Task

Task control commands allow users to pause, resume, or cancel (remove) tasks being performed
on arrays. Full task control can be used on Create, Consistency Check, and Check Bitmap tasks.
On Restores with dedicated or global spares, the task can be removed, but the array returns to the
Critical state.

Note: Task control can be used only when a task is running on an array.
449.1 Interrupt, Cancel, or Resume a Task

1. Inthe Array View section, select the array on which a task is being performed.
2. Atthe Array menu, click Task and select one of the following:

e Pause to interrupt the task.

e Remove to cancel the task.

e Resume to interrupt the task.

4.4.10  Check for Consistency

For redundant-type arrays only, the Consistency Check task is available at the Array menu. When
this task is selected it starts the process of verifying that the mirror drive consistency for fault-
tolerant disks is correct. If inconsistent areas are found, they are corrected during this process.

Chapter 4 AMD RAIDXpert2 Graphical User Interface (GUI) 63



[Public]

AMDA\

AMD RAID® User Guide 53987 Rev. 3.31 April 2025

Having consistent arrays is very important. If an array is inconsistent and a drive fails, data is lost.
RAIDXpert2 is designed to maintain consistent arrays, but it is good practice to run frequent
consistency checks.

When a redundant array is created using Create, and Skip Initialize is not checked (default), a
Consistency Check is performed automatically. Consistency Checks that run during a Create task
can be removed (by highlighting the array and selecting Task > Remove), but the array created is
not redundant. Arrays are not protected unless a Consistency Check runs end-to-end.

After a Consistency Check is started, adjust the priority of its task relative to user 1/0 activity. Use
the Task Priority option (see Section 4.4.8, Change the Priority Level of a Task, on page 63).

4.4.10.1 Before you Begin

e The Consistency Check command can be started at any time on a redundant-type array, as
long as another task is not running on the array.

e The Consistency Check command can be started while under /O load.
e |f the array state is Critical, the Consistency Check fails.

e To estimate remaining time for a Consistency Check, note the percentage of the task that
is completed (hours:minutes:seconds). Details are displayed by the array in the Array
View section of the Array Status window.

4.4.10.2 Manually start a Consistency Check

1. Select the array on which to run the Consistency Check in the Array View section.
2. Select Check Consistency at the Array menu.
3. Click Start.

4.4.10.3 Manually stop a Consistency Check

1. Select the array on which to stop the Consistency Check in the Array View section.
2. Select Check Consistency at the Array menu.
3. Click Stop.

44.11  Scanan Array in the Background

A Background Array Scan task performs a continuous background read operation of an array,
accessing at least one copy of every block of the array from beginning to end.

The user manually starts a Background Array Scan. It runs continuously until the user stops it.

Although a Background Array Scan can run while an array is engaged in other tasks, it is
recommended that it runs while the array is idle (that is, when there is no I/O to or from the array).
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4.4.11.1 Enable or Disable a Background Array Scan

1. Select the array on which to run the Background Array Scan in the Array View section.
2. Select Background Array Scan at the Array menu.
3. Enable or disable the Background Array Scan.
e Select Start to enable a Background Array Scan.
e Select Stop to disable a Background Array Scan.
Note: A Background Array Scan can also be enabled for an array when it is created.

44.12  Add or Remove Dedicated Spares
If a dedicated spare is added, make sure there is adequate space on the dedicated spare.
4.4.12.1 Add a Dedicated Spare

1. Select the array on which to assign a dedicated spare in the Array View section.
2. Double-click on the disk chosen as the dedicated spare in the Disk List section.
3. Select Options at the Disk menu.

4. Select Assign as Dedicated Spare, then click Confirm.

4.4.12.2 Remove a Dedicated Spare Assignment

1. Select the array from which to remove a dedicated spare in the Array View section.
2. Select Options at the Disk menu.
3. Select Remove as Dedicated Spare, then click Confirm.
TIP: For additional information see Section 2.10, Sparing Options: Disks and Arrays, on page 31.

44.13  Addor Remove Global Spares
If a global spare is being added, make sure there is adequate space on the global spare.
44.13.1 Adda Global Spare

1. Select the disk chosen as the global spare in the Disk List section.
2. Select Options at the Disk menu.
3. Select Assign as Global Spare, then click Confirm.

4.4.13.2 Remove a Global Spare

1. Select the disk to be removed as the global spare in the Disk List section.
2. Select Options at the Disk menu.
3. Select Remove as Global Spare, then click Confirm.
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44.14  Hide an Array
Hide allows the user to hide the array from the operating system.
4.4.14.1 Hidean Array

1. Select the array to hide in the Array View section.
2. Select Hide at the Array menu. The array will disappear from the Array View.
Note: If the array is currently hidden, select Array > Un-hide to display it.

4.4.15 Secure Erase

Secure Erase is used for erasing all data on an array and ensuring that it will be unrecoverable,
even with advanced data recovery techniques.

Data is Securely Erased By:
e Hiding the array from the OS

e Writing over each region of the disk with 3 patterns (0XxAA, 0x55, and random)
e Using a 4th pass with all zeros to ensure that a RAID1 will be consistent

After secure erase is complete, a user can manually delete the array or reuse it. If the user chooses
to reuse it, it must be unhidden using the procedure in Section 4.4.14, Hide an Array, on page 66.

CAUTION: When an array is securely erased, the data on the array is lost.
4.4.15.1  Securely Erasing an Array

1. Select the array to erase in the Array View section.
2. Select Secure Erase at the Array menu, then click OK.

4.5 Working with Views

The View menu allows the user to:
e Refresh the display

e Display the event view

e Display the Application log

e View Controllers

e Theme — Dark, light

e Icon Size — Small, Large

e Font Size — Small, Normal, Large
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4.5.1 Display or Hide Controller Event Log Panel
To display or hide the Controller Event Log, select Event View at the View menu. When the

Controller Event Log panel displays, a checkmark is displayed by the Event View option at the
View menu.

4.5.2 Log Window

The [system name]: View Log window displays all the messages generated by RAIDXpert2. All
messages are logged, not just the ones enabled at Options > Notification.

All messages received from the RAIDXpert2 driver are sent to a message log file. If desired,
change the name of this file in the Notification window.

By default, notification events in Windows-based systems are saved to:
$Program Files%\RAIDXpert2\rc service.log

Notification events in Linux-based systems are saved to: /var/log/rc service.log
Select Log to view the RAIDXpert2 messages at the View menu.

453 Refresh the Display

Select Refresh at the View menu to refresh the display.

4.5.4 View Controllers

1. Select View Controllers in the View menu. A window lists the system Controller List.

Note: The list includes Controller Number, Type, Serial Number, Port Count, PCI Vendor
ID, PCI Device ID, PCI SubVendor ID, PCI SubDevice ID, Bus, Slot, Function.

2. Click OK to close the window.
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4.6 Working with Options

4.6.1 Event Notifications

The Event View section of the Array Status window displays the priority listing. The event log
priority levels, in ascending order, are indicated in Table 25.

Table 25. Event Log Priority Levels

Event Priority

Description

Low

Displays messages for normal system operations. (This event is not displayed unless
requested by the user.)

Informational

Displays information that might be useful to know.

Warning System user should be informed about this event, but probably does not need to take
action.
Critical The system user must be informed about this event and should take action.
Fatal The RAIDXpert2 driver is fatally damaged and the RAID subsystem has shut down.
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4.7 Transforming a RAIDADIle Array

1. Inthe Array List, select the RAIDADble array
2. Right Click and select Transform

3. Click Same, select (check mark) the selected device(s), set the RAID level, Capacity, then
click Commit

Note: RAIDABLE array is formerly known as RAID Ready array.

Note: To create a redundant RAID1 array, the new disk must be the same size or greater than the
RAIDABLE disk.
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Chapter 5 rcadm Command Line Interface

Tool

51 What is rcadm?

The rcadm program is a command line interface (CLI) tool for managing RAIDXpert2 in the
Windows, Linux, or EFI operating system. See Section 5.8, on page 77, for rcadm.efi Information.

The rcadm program initiates RAIDXpert2 operations, such as:

e Manage RAIDXpert2, arrays and disks (see Section 5.2, Manage Arrays and Disks: rcadm
--manage, on page 71).

e Create new arrays (see Section 5.4, Create New Arrays: rcadm --create, on page 76).
e Delete arrays (see Section 5.5, Delete Arrays: rcadm --delete, on page 76).
e Transform arrays (see Section 5.6, Transform Arrays: rcadm --transform , on page 77).

e Follow or monitor arrays and disks (see Section 5.7, Follow or Monitor Arrays and Disks:
rcadm --follow, on page 77).

e Information on drive and array states.

The rcadm program has five primary modes, with most primary modes having additional optional
arguments. The five modes of operation are indicated in Table 39.

Table 26. Modes for the rcadm Program

Mode Usage

Manage Uses the rcadm --manage command to manage and query RAIDXpert2,
arrays, and disks.

Create Uses the rcadm --create command to create a new array.

Delete Uses the rcadm --delete command to delete arrays.

Transform |Usesthe rcadm --transform command to transform an array.

Follow Usesthe rcadm --follow command to follow or monitor arrays and disks.

Follow these instructions to issue the command on the operating system. Also, see Section 5.3,
View Help from the Command Line, on page 75.
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5.1.1 To Use rcadm with a Linux® Operating System
By default, rcadm is installed in /usr/bin.
512 To Use rcadm with a Windows® Operating System

e Change directoriesto C: \Program Files (x86)\RAIDXpert2.
e Runthe rcadm.exe command from there.

or
e AddC:\Program Files (x86)\RAIDXpert2 to the system or user path
environment variables.

5.2 Manage Arrays and Disks: rcadm --manage

The rcadm --manage or rcadm -M command allows the user to view information about
RAIDXpert2 and manage the arrays and disks.

For example, the user can:

e Set cache attributes for arrays.

e Set priority levels for tasks on an array.
e Hide and unhide arrays.

e Listarrays.

e Initialize disks.

e Query information about disks.

e Add and remove spares from an array.
e Set cache attributes for disks.

5.2.1 Understand Query Output

When the rcadm --manage --query-all or rcadm -M -ga command is used,
information about the disks and arrays for the system is displayed.

To see information about a specific controller, disk, or array use the rcadm --manage --
query command, in conjunction with the appropriate options.
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522 rcadm Controller List Elements
Table 27. rcadm Controller List Elements
Element Description
Number Controller number assigned by RAIDXpert2
Type Model number of the controller
Serial Number Serial number of the controller
Port Count The number of ports supported by RAIDXpert2
PCle® Vendor ID The PCle vendor identification number
PCle Device ID The PCle device identification number
PCle SubVendor ID | The PCle sub-vendor identification number
PCle SubDevice ID The PCle sub-device identification number
Bus PCI bus number, assigned to the controller
Slt Slot: Position of controller/device on assigned bus, normally 0
Fun Function: Programming interface presented by controller/device
SAS Address (WWID) | The SAS Address (world-wide identification number)
BIOS Version The version of the AMD RAID Configuration BIOS
523 rcadm Disk List Elements
Table 28. rcadm Disk List Elements
Element Description
Disk Disk number assigned by RAIDXpert2, corresponding to SATA channel ID.
State State of the disk (Online, Failed, Unknown)
Disk Type Disk type (Disk, Legacy, New, ATAPI)
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Table 28. rcadm Disk List Elements (continued)

Element

Description

Port Type

Port type (SATA, SATA I, SATA 111, SSD, NVMe)

Port Speed

The negotiated speed of the port
Note: For NVMe the port type is always N/A.

Size

Total size of the disk:

e 1MB =1,000,000 bytes

e 1GB=1,000,000,000 bytes

Note: Because the ATA storage industry has standardized the meanings of

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units.

Free Space

Total amount of space unused on the disk

Largest Free Space

Largest contiguous unused space on the disk

GS

Indicates if the disk is assigned as a global spare

Trim

None, Simple, Advanced

Informed Hot Swap

Indicates whether a disk supports live disconnect and removal.

Ca Current disk cache setting (NC = No Cache, R = Read Cache, W = Write
Back Cache, RW = Read + Write Back Cache).
Note: For NVMe the CA is always NC.

Ctrl Chan Disk controller and channel number.

Vendor Disk vendor

Model Number

Disk model number

Firmware Version

Disk firmware version

Serial Number

Disk serial number
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52.4 rcadm Array List Elements
Table 29. rcadm Array List Elements
Element Description
A Array number assigned by RAIDXpert2.
Type RAID type.
0O.S. Name Name assigned by the operating system to the array. The name shows as

“Hidden” if the array is hidden from the operating system. The name
shows “??7” if the array is Offline.

Sys or System Device

Indicates whether or not the array is being used as a system disk under
Windows.

State

State of the array (Normal, Critical, Offline).

Size or Capacity

Total size of the disk:

e 1MB =1,000,000 bytes

e 1GB=1,000,000,000 bytes

Note: Because the ATA storage industry has standardized the meanings of

MB as 1,000,000 bytes and GB as 1,000,000,000 bytes, RAIDXpert2
reports the same units.

Hide Whether the array is hidden from the operating system.

Id Globally unique identifier for the array assigned by RAIDXpert2.

Task Task type (Transform, Check, Check_Bitmap, Not_Active, Create,
Restore)
Note: See Section 2.7, Array Tasks: Starting and Stopping Tasks, on page
27 for detailed definitions.

Task State The state of the task (Started, Paused, Completed)

% The progress of a current array task, such as a Create or Transform, shown
as percent complete

CA Current array cache setting (NC=No Cache, R=Read Cache, w=Write Back
Cache, RiWw=Read + Write Back Cache).
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Table 29. rcadm Array List Elements (continued)
Element Description
CTS Cache tag size specifies the amount of data per disk in a stripe. Supported

sizes are 64kB, 128kB or 256kB
Any Array with only HDD/SSD will have default CTS of 64k
Any Array with NVMe/HDD/SSD will have default CTS of 256k

Scan Background scan enabled (Yes/No)
Name User-supplied name for the array
Dedicated Spare Indicates the number of dedicated spares assigned to the array

(--verbose mode only)

Disk Listing of disks that are part of the array
Used Capacity used of a specific disk
Offset Location on the disk where the array begins

5.3 View Help from the Command Line

5.3.1 To view a List of the Major Modes of Operation
Type: rcadm —--help Or rcadm -7

53.1.1 To View Help for a Specific Mode and its Options

Type: rcadm <mode> --help Or rcadm < mode> =72

For example, typing rcadm --manage --helpor rcadm -M -2 displays help and
examples regarding that specific mode and its options.

53.1.2 To view the rcadm Man Page on a Linux® System

Type: man rcadm
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5.4 Create New Arrays: rcadm --create

The rcadm --create or rcadm -C command allows new arrays to be created. As many as
twelve arrays can be partitioned and created across all disks.

Portions of disks can be used to create arrays, while other arrays are using different portions of the
same disks. A maximum of twelve arrays can be created.

54.1 Before You Begin

Creation of arrays, even redundant arrays, allows users immediate access to the arrays. If the
system reboots, the creation process continues where it left off.

CAUTION: In some circumstances, more than twelve arrays are possible. They might appear to
function properly but are not supported.

Note: The ability to create RAID10 or RAIDABLE arrays may not be available on your system.
54.2 Example

To create a1 GB RAIDL1 array using disk members 1, 2, and 3, type:
rcadm -C -rl -d 1 2 -s 1000

To see more examples, type: rcadm -C -2

5.5 Delete Arrays: rcadm --delete
The rcadm --delete or rcadm -Dcommand allows the user to delete one or more arrays.

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone and it is very unlikely the data can be recovered.

5.5.1 Before You Begin

e If the operating system is using an array it cannot be deleted.

e Ifanarray is accidentally deleted, and the user wants to try and recover the data, create an
array using the same disks, same size, and same cache, and use the --leave-existing-data
option. This option writes new configuration information to the array while trying to use
the exact same disk space as before.

552 Example
To delete array 1, type: rcadm -D -a 1

To see more examples, type rcadm -D -2
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5.6 Transform Arrays: rcadm --transform

The rcadm --transform or rcadm -T command allows the user to transform (migrate) an

array from one RAID level to almost any other RAID level, and to expand the array dynamically,
even under 1/0O load.

5.6.1 Before You Begin

e An array cannot be transformed to a smaller-sized array. New arrays must be either the
same capacity or larger.

e When using the task control option, a Transform can only be paused or resumed but not
removed.

e |f a spare has been assigned to the destination array, a fail-over task starts as soon as the
Transform completes, provided the spare is available after the Transform.

o If there are multiple arrays on a single controller, it might not be possible to transform
some of the arrays to a larger size. If the size of an array might be expanded in the future,
it is best to configure the available space as a single array.

5.7 Follow or Monitor Arrays and Disks: rcadm --follow

The rcadm --followor rcadm -F command allows the user to follow or monitor arrays

and disks. It polls the RAID subsystem for any status changes and logs them in the Windows
System Event Log.

5.7.1 Before You Begin
It is recommended that the user not run more than one instance of rcadm --follow at the same time.

If the user runs more than one instance of the command, each instance captures some of the
events, but no single instance captures all events.

5.8 rcadm.efi Information

The following list of commands is a partial reference; it is not complete. Use the command prompt
query for the complete list of commands.

5.8.1 rcadm -?
-?, ——help

Displays all primary rcadm commands, or if used after an option, displays help for that
specific option.

-log, --log-file
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Print output to a log file as well as standard output. Requires a log file name argument.
Overwrites existing file. Only one occurrence of this option on the command line is allowed.
Example: rcadm -M -ga -v -log status.txt

-C, -—--create

Command for creating arrays. Array types include linear (JBOD), volume (JBOD), RAIDO,
RAID1, RAID10, RAID10n, and RAIDABLE. Some of the major functions include assigning
spare disks; setting array size; and setting cache attributes.

-D, —--delete

Command for deleting arrays. This mode does not have any optional arguments.
-M, —--manage

Commands for managing and querying controllers, arrays, and disks. Some of the major
functions include querying for information, adding and removing dedicated and global spare
disks, setting cache attributes for arrays and disks, performing consistency checks on
redundant array types, initializing disks, prioritizing tasks for arrays, scanning arrays and disks
for changes in status, and hiding or unhiding arrays.

5.8.2 rcadm -M

MANAGE
-a, —-array
Used with certain options to specify arrays.
-as, —--add-spare
Adds a dedicated spare disk to an array. No space is reserved on the disk selected.

-rs, ——remove-—spare

Removes a dedicated spare disk from an array.

-ras, -—--remove-all-spares

Removes any spares from an array.
-ags, -—--—add-global-spare

Adds a disk as a global spare. No space is reserved on the disk selected.
-rgs, -—--remove-global-spare

Removes a global spare disk.
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-ca, —-cache-array

Sets the cache attributes for an array. Cache attributes include read cache (r), read and write-
back cache (rw), write-back cache (w), and no cache (nc).

-cd, —--cache-disk

Sets the cache attributes for a disk. Cache attributes include read cache (r), read and writeback
cache (rw), write-back cache (w), and no cache (nc).

-d, --disk

A required qualifier used with certain options to specify disks.
-h, --hide

Hides an array from the operating system.
-uh, --unhide

Unhides an array, making it visible to the operating system.
-id, --initialize-disk

Initializes a disk. If the disk is new and has not been used, you must initialize it before you can
create arrays.

-cm, --clear metadata

-n, —--name

Identifies an array with a user-supplied name. The name can be up to 30 characters, but only
17 of those characters display in the BIOS.

-p, —-priority
Sets an array's task priority from 1-10, with 10 being the highest priority.
-ptr, —--prepare-to-remove

Prepares an array and its devices to be physically removed from the system. This action hides
the array operating system.

-d, —~query
Lists information about specific controllers, arrays, and disks.
-ga, —--query-all

Lists information about controllers, arrays, and disks.
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-v, —--verbose

Modifier of the --query and --query-all option. Specifies more detail for arrays and disks.

—-rsc, ——rescan

Rescans the serial ATA (SATA) channels for new or removed disks.
-ej, --eject

Ejects (prepares for removal) a specified disk.
-sg, —--smart-get

Reads SMART attribute and log information for the specified drive(s).

-sa, —-scan-array <on|off>

Specifies if background array scan scanning is on or off.

-sp, —-smart-poll
Turns SMART polling on or off for the specified drive(s).

-t, —--task

Used to pause, resume, and remove tasks.

-ul, --unlink

Unlinks two arrays linked through a create copy operation.

SYNTAX and EXAMPLES
ADD SPARE
--add-spare -array <list> --disk <list>
-as —a <list> -d <list>
Examples: rcadm -manage -add-spare -array * --disk 1
rcadm -M -as -a 1 2 -d 5 6

REMOVE SPARE

--remove-spare —array <list> --disk <list>
-rs —a <list> -d <list>

Examples: rcadm -manage -remove-spare —array 5 —-disk *

rcadm -M -rs -a * -d 5

REMOVE ALL SPARES

--remove-all-spares —-array <list>
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-ras -a <list>
Examples: rcadm -manage -remove-all-spares —array 5

rcadm -M -ras -a *

ADD GLOBAL SPARE

-—add-global-spare -disk <list>
-ags -d <list>

Examples: rcadm —manage —add-global-spare —disk 1 2 3

rcadm -M -ags -d *

REMOVE GLOBAL SPARE

--remove-global-spare —-disk <list>
-rgs -d <list>

Examples: rcadm —manage —remove-global-spare —disk *

rcadm -M -rgs -d 5

CACHE SETTINGS FOR ARRAYS
—--cache-array <cache attribute> --array <list>
-ca <cache attribute> -a <list>
Cache attributes: <r> for read cache
<rw> for read and write-back cache
<w> for write-back cache
<nc> for no cache
Examples: rcadm -manage -cache-array rw —array *

rcadm -M -ca nc -a 1
Note: rcadm -M -rsc is required for the change to be presented to the OS.

DISK SETTINGS (Advanced)
Disk cache:

—--cache-disk <cache attribute> --disk <list>
-cd <cache attribute> -d <list>

Cache attributes: <r> for read cache

<rw> for read and write-back cache

<w> for write-back cache
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<nc> for no cache

Examples: rcadm -manage -cache-disk r -disk 1 2 3

rcadm -M -cd w -d *

HIDE ARRAY

--hide —-array <list>
-h -a <list>
Examples: rcadm —manage —hide —array 5 6

rcadm -M -h -a 4

UNHIDE ARRAY

--unhide -array <list>
-uh -a <list>
Examples: rcadm -manage —-unhide -array *

rcadm -M -uh -a b5

INITIALIZE DISK

--initialize-disk -disk <list>
-id -d <list>
Examples: rcadm -manage —-initialize-disk -disk *

rcadm -M -id -4 1 2 3
NAME ARRAY

--name “name” -array <list>
-n “name” -a <list>
Examples: rcadm -manage -name “System Disk” -array 5

Rcadm -M -n “Backup Disk” -a 4

PREPARE TO REMOVE ARRAY

--prepare-to-remove --array <list>
-ptr -a <list>

Examples: rcadm --manage --prepare-to-remove --array 2
rcadm -M -ptr -a 4

April 2025

QUERY
-—-query [--array <list>] [--disk <list>]
[--verbose]
-q [-a <list>] [-ct <list>] [-d <list>] [-V]
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Examples: rcadm --manage --query --array 1 --disk —--verbose

rcadm -M -g —a 1 2 3 -d -v

QUERY ALL
-—query-all
~qa
Example: rcadm --manage --query-all
EJECT DEVICE
--disk <list>
Example: rcadm -M --eject --disk *
rcadm -M -ej -d 1 2

RESCAN DISKS

--rescan
-rsc
Example: rcadm --manage --rescan

SMART GET

--smart-get --disk <list> {--log-number <log number=0..5> | --
attributes}
-sg -d <list> {-1 <log number=0..5> | -at}

Example: rcadm --manage --smart-get --overview --log-number * --disk *

rcadm --manage —--smart-get --attributes --disk 1 2

SCAN ARRAY

-—-scan-array <on|off> --array <array number>
-sa <on|off> -a <array number>
Example: rcadm -M --array 1 --scan-array on

rcadm -M -a 1 -sa off

SMART POLL

--smart-poll <on|off> --disk <list>
-sp <on|off> -d <list>
Example: rcadm --manage --smart-poll on --disk

rcadm -M -sp off -d 1 2 3

TASK CONTROL

-—-task <task operation> --array <array number>
-t <task operation> -a <array number>

Task Operation
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<pause> to temporarily pause a task
<resume> to continue running a task
<remove> to permanently remove a task
Examples: rcadm --manage --task pause --array 5

rcadm -M -t remove -a 4

TASK PRIORITY

--priority <1..10> --array <list>
-p <1..10> -a <list>
Examples: rcadm --manage --priority 5 --array 6

rcadm -M -p 1 -a
UNLINK ARRAY

--unlink --array <array number>
-ul -a <array number>
Examples: rcadm --manage --unlink --array 2

rcadm -M -ul -a b5

583 rcadm -C

CREATE
Long form:
rcadm --create <raid type> --disk <list> [--size <size mb>]
[--sub-member <num>] [--spare-disk <list>]
[-—no-sync] [--d-spare] [--cache <r,rw,w,nc>]
[-—-max-size] [--name "name"] [--priority <1..10>]
[-—zero] [--scan-array]

Short form:

rcadm -C <raid type> -d <list> [-s <size mb>] [-sub <num>]
[-sp <list>] [-ns] [-ds] [-ca <r, rw, w, nc>] [-ms]
[-n "name"] [-p <1..10>] [-z] [-sa] }
RAID Types:

--volume, -v Single disk or concatenation of disks (JBOD)
--raidable, -ra Single disk, RAIDABLE
--raid0, -r0 Stripe of two or more disks
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--raidl, -rl Mirror of two disks
--raid5, -r5 Stripes data as well as parity, across all disks in the array
--raidl0, -r10 Stripe set of mirror sets

OPTIONS

-sp, —-spare-disk
Specifies the dedicated spare disk or disks to assign, with a maximum of four. No space is
reserved on the selected disks.

-s, —-size
Specifies the size of the array in MBs. If you do not use this option, the largest possible size is
used by default.

-ns, —--no-sync
Disables background synchronization of redundant types when creating the array.

-ca, —-cache
Specifies a cache setting for the array(s): read cache <r>, read and write-back cache <rw>, write-
back cache <w>, or no cache <nc>. The default is read and write-back cache <rw>.

-cts, -—-cachetagsize
Specifies the Cache Tag Size. This is the amount of data per disk in a stripe. Supported sizes are
64, 128, or 256; sizes in kB.

Please refer to Table 14, Default Cache Tag Size, on page 37.

-ms, —--max-size
Prints the maximum possible size for an array without actually creating an array.

-n, -—--name
Identifies an array with a user-supplied name. The name can be up to 30 characters, but only 17 of
those characters display in the BIOS.

-p, —--priority
Sets the background initialization task priority from 1 to 10, with 10 being the highest priority. For
redundant array types only.

-led, --leave-existing-data

Leaves the existing data on the disks untouched after the array is created. This option can be used
to try to recover user data when an array has been accidentally deleted or the configuration
information is lost but the data is still intact. Unless you immediately recreate the array after
deleting it and no other tasks have been performed, the likelihood of recovering data with this
method is very low.

-d, --disk
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A required qualifier used with the --create option to specify the disk or disks to be included in the
array.

—Sda, ——SCan—array
Specifies that a background array scan should be continuously run whenever the array is idle
(Default is off).

-Z, ——Zero

Zero the array in the foreground. This method is faster than doing a background consistency
verifies if the array is a redundant type. For non-redundant types, the zero option can be used to
verify all blocks in the array can be accessed.

EXAMPLES
Example: Create a RAID1 set of the maximum possible size using all disks.
rcadm -C -raidl --disk *

Example: Create a RAID1 set of the maximum possible size, with a spare disk and without a
background initialization task.

rcadm -C --raidl --spare-disk 3 --disk 1 2 --no-sync

5.84 rcadm -D

DELETE
Long form:

-—-delete --array <list> [--no-ask]

Short form:

-D -a <list> [-na] [-cg <group number>]
OPTIONS
-na, --no-ask

If the no ask option is specified the array is deleted without confirmation.

EXAMPLES:
Example: Delete arrays 1 and 2.
rcadm -D --array 1 2

Example: Delete all arrays.

rcadm -D --array
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Chapter 6

Troubleshooting

AMD RAID® User Guide

6.1

Troubleshooting

The chapter discusses major categories of troubleshooting:

Note: When booting from an AMD RAID boot array, it takes about 4 seconds longer than a native

6.2

Problems with system startup.
Warning messages that might appear at the Power-On Self-Test (POST) screen.

Problems with arrays.
Problems with disks.

Template for adding the warning message when someone tries to create a RAID5 on a
system that is not supported.

installation to boot.

System Startup Problems

This section correlates possible startup issues and corrective actions for system boot.

Table 30. System Does Not Boot

Possible Causes

Corrective Actions

Controller mode is set
incorrectly during system
startup

In the system’s BIOS screen, ensure SATA is set to RAID and NVMe
RAID is set to Enabled.

A bootable array is in an
Offline state

Restart the system.

Enter the system’s BIOS screen.
Check the state of the bootable array.
Check for missing or offline disks.

Chapter 6

Troubleshooting

87



[Public]

AMDZ1

AMD RAID® User Guide 53987 Rev. 3.31 April 2025

| Table 31. System No Longer Boots in Linux

Possible Causes Corrective Actions

AMD RAID Drivers are | Synchronize the drivers with kernel:
not synchronized with the 1. Click the Terminal icon.
Linux Kernel.
a. Enter: yum update
b. Enter: yum groupinstall “Development Tools”

Warning: If the system kernel version is updated, perform step 2
before the system is rebooted. Failing to do so may result in the
system failing to boot.

2. Change to the RAIDXpert2 driver sdk directory, and
enter:
a. Enter:cd /opt/raidxpert2/driver sdk
b. Enter: sudo ./install
3. Wait for the command to complete, then reboot the
system.
For more information see the below Linux Quick Start Guides:

e AMD RAID™ Quick Start Guide for Red Hat® (RHEL) Operating
System, order #56963

o AMD RAID Quick Start Guide for Ubuntu Desktop Operating
System, order #56966

Table 32. BIOS Configuration Utility Does Not Display

Possible Causes Corrective Actions

The controller mode is set | In the system’s BIOS screen, ensure SATA is set to RAID and NVMe
incorrectly in the system | RAID is set to Enabled.

BIOS
Possible Causes Native AHCI installation.
Corrective Actions A Native AHCI installation will not boot into the OS, after changing

the BI1OS settings to RAID mode.

88 Troubleshooting Chapter 6



[Public]

AMDZ\

53987 Rev.3.31 April 2025

6.3

Array-Related Errors

e Table 33. Cannot Create an Array, on page 89

e Table 34. An Array is in a Critical State on page 90
e Table 35. An Array is in an Offline State, on page 90
e Table 36. Cannot Assign a Dedicated Spare to an Array, on page 91
e Table 37. Cannot Create a Global Spare on page 91
e Table 38. Recreate a Deleted Array, on page 92

e Table 39. Deleted Secondary Array Availability Using HIl During Hibernation Resume

on page 92

Table 33. Cannot Create an Array

AMD RAID® User Guide

Possible Causes

Additional Information

Corrective Actions

The disk is not displayed.

The controller cannot communicate
with the disks.

See Section 6.4.1, Troubleshooting
Disks, on page 93.

Insufficient free space
available on the selected
disks

Select a different combination of
disks.

Incorrect number of
disks selected for the
desired RAID level

See 2.2, RAID Levels, on page 23,
for a description of RAID levels and
the allowable number of disks used
with each RAID level.

Select the correct number of disks.

Chapter 6

Troubleshooting

89




[Public]

AMDA\

AMD RAID® User Guide

Table 33. Cannot Create an Array (continued)

53987 Rev. 3.31 April 2025

Possible Causes

Additional Information

Corrective Actions

The desired disk is
unavailable.

The disk is a dedicated spare for a
different array.

The disk is full.

The disk’s available capacity is
insufficient.

Select a different disk.

The disk has SMART
errors.

An array can contain a SMART
error device, that has started to
report SMART errors after the
Array was created.

RAIDXpert2 cannot be used to
create an array with a disk that has
SMART errors.

Replace the SMART error device

The system already has a
maximum of twelve

Delete unused arrays.
CAUTION: Deleting an array

arrays

permanently destroys all data on the
array. This action cannot be undone.
It is unlikely data can be recovered.

Table 34. An Array is in a Critical State

Possible Causes

Additional Information

Corrective Actions

One or more disks in the
array have failed or been
removed.

Due to the failed disk or disks, the array no longer
maintains redundant (mirrored or parity) data.
The failure of an additional disk results in an
Offline state and lost data.

See Section 6.4.1,
Troubleshooting Disks,
on page 93.

Table 35. An Array is in an Offline State

Possible Causes

Additional Information

Corrective Actions

The array has lost the
maximum allowable
disks per RAID level.

One or more disks have failed.

e If the array is non-redundant, the failure of a
single disk causes the array to fail.

o If the array is redundant, the failure of two or
more disks causes the array to fail.

The array cannot be restored (rebuilt).

See Section 6.4.1,
Troubleshooting Disks,
on page 93.
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Table 36. Cannot Assign a Dedicated Spare to an Array

AMD RAID® User Guide

Possible Causes

Additional Information

Corrective Actions

The RAID level does not
allow dedicated spares.

Dedicated spares cannot be created for
Volume or RAIDO arrays.

o Create an array with a different
RAID level and assign a
dedicated spare.

e Create a global spare.

The designated disk does
not have sufficient
capacity to be a dedicated
spare

The capacity of the disk selected to be
dedicated spare must be equal to or
larger than the capacity of the smallest
disk in the array.

a |Select a different disk.

Table 37. Cannot Create a Global Spare

Possible Causes

Additional Information

Corrective Actions

The disk is already part
of an array

A global spare cannot be selected if it
is already part of an existing array.

Select a different disk.

There are no empty disks
available or the disks
have not been initialized

A disk with a legacy state can be
initialized, if desired, but it is no
longer legacy (initialization adds
RAIDXpert2 configuration
information to the disk).

Install additional disks.
Initialize the disks.

CAUTION: When a disk is initialized,
all data on the disk is lost.

The disk assigned as the
global spare has failed or
is missing.

See Section 6.4.1, Troubleshooting
Disks, on page 93.
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Table 38. Recreate a Deleted Array

Possible Causes Additional Information Corrective Actions
An array(s) was This procedure might 1. Atthe Array pop-up menu, select Create.
accidentally deleted, or |recreate a deleted array and|2. Create a new array using the same settings
the wrong array was with its data intact. as the deleted array.
deleted However, this is not

e The same disks.
guaranteed to occur. Th RAID RAID level
If I/0 was running to the * 'hesame type ( evel)

deleted array(s) just prior * The same capacity.

to it being deleted, there e The same cache options.

might be some data loss in Check Leave Existing Data Intact.
the recreated array(s). Click Create

If multiple arrays were .
deleted. all of the deleted Ensure the se'ttlngs are the same as the
deleted array:

arrays must be recreated in )
order to recover the desired| ~ ® The same drive letter.
array. ¢ The same RAID type (RAID level).

e The same disks.
¢ The same capacity.
e The same cache option

6. Check the data files of the array for
corrupted or missing files, incorrect file
extensions, and so on.

o~ w

Table 39. Deleted Secondary Array Availability Using HII During Hibernation Resume

Possible Causes Corrective Actions

Array(s) are seen online in Operating After array deletion in RAIDXpert2 Configuration Utility
system after array deletion in (HI1) during hibernation resume, system needs to be reset for
RAIDXpert2 Configuration Utility (HII) |the changes to take effect.

during hibernation resume.
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6.4 Disk Related Errors
Table 40. Disk Errors
Possible Causes Additional Information Corrective Actions

A disk has been
removed from an array

A disk is not visible in See Section 6.4.1, Troubleshooting Disks.

the BIOS Configuration
Utility or is offline

RAIDXpert2 cannot The dedicated spare is not visible
communicate with the |in the BIOS Configuration Utility

spare or is offline.
The disk cannot be Only disks that are Ready can be {¢  Ensure disk is not already a member
initialized initialized. of an array.
CAUTION: When a disk is e Ensure disk is still assigned as a
initialized, all data on the disk is global or dedicated spare.
lost.

e Ensure disk is reporting a Ready state.

0.4.1 Troubleshooting Disks

Perform the following actions when there may be a problem with a disk.

Ensure there is no damage to the system’s backplane.

Ensure all cables are installed correctly.

Ensure the disk is seated correctly in the backplane or bay and the latch is secured.
Reinsert the disk.

Replace the disk.

After reconnecting, reseating, reinserting, or replacing a disk, perform a re-scan and
initialize the disk.

CAUTION: When a disk is initialized, all data on the disk is lost.

If problems with a disk caused an array to go Critical, it may be necessary to also assign a
dedicated or global spare for the array.

If problems with a disk caused an array to go Offline, data may have been lost. Recover lost data
from a backup storage source.
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Chapter 7 Safety Precautions

This section includes general safety precautions and specific RAIDXpert2 precautions. Many are
shown in context throughout this guide. Read and keep this guide for future reference.

In this section, CAUTION indicates that a failure to follow directions could result in damage to
equipment or data.

7.1 Storage Device Precautions

CAUTION: Assigning a dedicated spare does not reserve space on the disk. Therefore, an
automatic restore is not guaranteed if a disk fails. If a disk fails, create space on the
disk for the fail-over to complete, or assign a different disk with enough space. If a
dedicated spare is assigned and a disk fails, the restore process starts automatically if
there is enough space available on the dedicated spare.

CAUTION: It is recommended to create only one array for the OS installation. If more arrays are
needed, they can be created in the OS GUI/CLI or HII, after the OS installation
completes.

CAUTION: If a disk is part of an AMD RAID array, the disk cannot be selected for initialization.
To initialize the disk anyway, delete the AMD RAID array. Data on the disk is deleted
during initialization, so ensure the correct disks are chosen to initialize.

CAUTION: A legacy disk can contain valid data. When a legacy array is deleted, or when its
corresponding legacy disk is initialized, the data is lost.

CAUTION: When a disk is initialized, all data on the disk is lost.

CAUTION: AMD recommends not using SMR hard drives with AMD RAID systems because it
can cause poor performance or failures. SMR drives are not suitable for workloads
that require many random writes (such as boot drive). If used with RAID, the multiple
SMR drives and background RAID tasks (such as creates and rebuilds) compound any
issues or problems.

General notes and guidelines:

e Volume, RAIDO, RAIDS5, or RAID10 arrays can be created or transformed by a maximum
of eight (8) NVMe and/or SATA disks.

e RAIDL can be created or transformed by a maximum of two (2) NVMe and/or SATA disks.

e RAID on AMD platforms supports M.2 ports, both AMD SATA controller and PCle M.2
NVMe. At any time, each M.2 port can support either M.2 SATA or M.2 NVMe, but not both.
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e Individual disks that are not part of a RAID array are not listed in Device Manager under the
Disk Drive section. Individual Disks can be managed through the RAIDXpert2 UWP-based
interface (Windows only), RAIDXpert2 utility (HII), and the EFI shell.

e Instead of a shutdown, AMD recommends performing a reset/reboot of the system whenever
the user is adding or moving a SATA M.2 SSD or NVMe device(s).

— Inthe OS, issue a reset/reboot.

— Wait for the AMD BIOS screen to display, press esc to enter the BIOS.
— Power off the system.

— Install or remove the necessary device(s).

— Power on the system and allow the OS to boot properly.

e When "NVMe RAID" = enabled, all NVMe devices connected to the system are controlled by
the AMD RAID driver (includes all U.2 NVMe drives, M.2 NVMe drives, and PCle NVMe
add-in cards).

e When SATA = RAID, all SATA devices connected to the system are controlled by the AMD
RAID driver (includes all HDD, SSD, ATAPI devices).

7.2 Array Precautions
CAUTION: Windows can only be installed to the first AMD RAID array.

CAUTION: Deleting an array permanently destroys all data that is on the array. This action
cannot be undone, and it is very unlikely the data can be recovered.

CAUTION: Do not delete the first array listed in the Arrays section if it is the AMD RAID
bootable array. Doing this deletes the operating system and AMD RAID files.

CAUTION: Do not initialize a disk that is part of an array. Initializing a disk in a non-redundant
array deletes the array and its data. The array no longer appears in Array View. This
is especially true for a non-redundant bootable array. Initializing a disk in a non-
redundant bootable array causes the array to fail and deletes the operating system,
AMD RAID files, and device drivers.

CAUTION: Leaving Write Back Cache enabled can increase the likelihood of data being
corrupted if the system experiences a power interruption or unexpected shutdown.

CAUTION: In Windows®, prior to removing an array, remove its drive letter.
CAUTION: In Linux®, prior to removing an array, unmount the array.

CAUTION: All data contained in an AMD RAID array are lost if any member of the array is
migrated to a non-AMD RAID system.
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CAUTION: When an array is securely erased, the data on the array is lost. The array remains
hidden after the secure erase completes. The user must unhide the array for it to be
available for data operations.

CAUTION: In some circumstances, more than twelve -arrays are possible. They might appear to
function properly but are not supported.

CAUTION: If the user creates an array using Skip Initialization, any new data written is
redundant. But if a Consistency Check is performed, errors may be reported because
the unwritten areas of the array have not been made consistent.

CAUTION: AMD RAID does not support Thunderbolt (TBT) devices.

CAUTION: It is recommended that NVMe hotswap actions are performed via RAIDXpert2, not
systray.

7.3 Controller Precautions

CAUTION: Hot-swapping is not recommended for disks that are part of AMD RAID boot array.

CAUTION: A Native AHCI installation does not boot into the OS after changing BIOS settings to
RAID mode.
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